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ABSTRACT 

This study seeks to further constrain near-bottom hydrodynamic current conditions 

required to mobilize native sediments on a high-energy sediment starved shelf environment and 

link these data to changes in sidescan sonar imagery of the inner-shelf environment of Onslow 

Bay, NC.  A bottom-mounted upward looking Acoustic Doppler Current Profiler (ADCP) 

deployed at the OB3M study site on the lower sand flat adjacent to a low-relief marine 

hardbottom recorded hourly flow velocity profiles from a depth of 17.7 m.  The lower sand flat is 

composed of two dominant surficial lithofacies consisting of patchy, but well-defined areas of 

well sorted fine sand and poorly sorted coarse grained material. A dual frequency high-resolution 

sidescan sonar system was utilized to biannually survey a 5.5 by 3.7 km area encompassing the 

OB3M site between March 2002 and October 2003.  Mosaic imagery obtained from these 

surveys were used to document seasonal changes in bottom characteristics in response to twenty-

three identified sediment mobility events.  Measurable contributions from semidiurnal tidal 

flows, mean current flows dominated by subtidal wind-generated currents, as well as wave-

generated oscillatory motions in the near-bottom layer during storm and non-storm conditions 

have been identified for the nineteen-month period bracketing two tropical storm seasons off the 

North Carolina coast.  Calculated critical shear velocity values due to the combined effects of 

waves and currents indicate that the fine-grained sand fraction was mobile more than 66% of the 

period, frequently as incipiently suspended load and bedload, and rarely as fully suspended load.  

Quantitative analysis of sidescan sonar imagery demonstrate that even though hydrodynamic 

conditions favor mobilization of fine sands, the gross morphology and sediment distribution at 

this inner-shelf site remained relatively unchanged after the occurrence of several commonplace 

high-energy events.  Seasonal sedimentation patterns, however; were found to be substantially 

altered after the passage of Hurricane Isabel within 225 km of the study site.  Evidence from this 
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study reveals that over the nineteen-month study period at this discrete site, the combined effects 

of typical high-energy events had little effect on the net distribution of bottom sediments, yet a 

singular extreme event was found to actively modify seabed sedimentation processes.    
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INTRODUCTION 

A number of hydrodynamic processes responsible for mobilization of sediment on the 

lower shoreface and inner continental shelf have been identified and described (Grant and 

Madsen, 1979; Niedoroda et al., 1985; Wright et al., 1986; Wright, 1987; Wright, et al., 1991; 

Wright, 1995; Thieler, 1996; Xu and Wright, 1998).  Tidal forces and the currents produced in 

response to astronomical forces are the best understood and most predictable of the physical 

forcing mechanisms initiating sediment mobilization on the inner continental shelf (Wright, 

1995).  Tidal oscillations and the resulting flows consist of a number of diurnal, semidiurnal, and 

longer period constituents, each of which is a response to forcing terms of varying frequency and 

magnitude.  The most influential of these partial tide constituents is the M2, main lunar 

semidiurnal with a period 12.42 hours.  Wright et al. (1991) and Wright et al. (1993) noted in 

recent research along the lower shoreface of Duck, NC that tidal currents are generally weak 

(maximum of 10-20 cm s-1 during spring tides) and individually have little significance in 

initiating sediment activity.  However, when combined with bed agitation by wave orbital and 

wind driven flows, tidal forces contribute to the overall shear stress on the seabed which aids in 

transporting sediment across and along the shelf (Wright et al., 1991; Wright et al., 1993). 

Low frequency wind-driven southerly currents produced most often in response to 

nor’easter type storms have been observed on the inner-shelf to be significant mechanisms 

responsible fore sediment mobility.  In addition to strong near-bottom along-shelf currents, these 

flows also have the ability to produce mesoscale across-shelf downwelling flows reaching 

velocities greater than 10 cm s-1 (Wright et al., 1986; Wright, 1995).  During study on the mid-

Atlantic Bight inner-shelf, which included only moderate energy storms, offshore and alongshore 

transport of sediment was noted in response to these elevated bottom currents (Wright et al., 
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1986).  Offshore of Wrightsville Beach, North Carolina much of the observed across-shelf 

transport is also hypothesized to be accomplished during storms by enhanced bottom stresses 

brought on by downwelling currents due to storm set-up, in conjunction with above average 

wave-induced oscillatory flows (Thieler et al., 1999).   

 By far, the primary means of initiating sediment mobility in the inner-shelf environment 

is through surface gravity wave orbital motions translating vertically through the water column 

and interacting with the seafloor (Wright et al., 1991).  In all cases, the effects of incident waves 

were the most significant processes leading to the mobilization of sediment as bedload and 

suspended load, but could be either positively or negatively influenced by the other physical 

processes occurring simultaneously during varying energy climates (Wright et al., 1991). 

Additional work by Wright et al. (1994) specifically focused on sediment dynamics during the 

extremely unique severe and prolonged Halloween Storm, which battered much of the eastern 

seaboard during late October 1991.  These data again demonstrated a strong relationship between 

wave orbital oscillations, mean current flows and wave-current interactions on sediment 

suspension fluxes and allowed the authors to better constrain the relative contributions of these 

processes to sediment transport under a given set of meteorological and oceanographic 

conditions.  

 In Onslow Bay off the North Carolina coast, it is well established that the near-bottom 

processes that produce along-shelf and across-shelf sediment transport are more powerful during 

storms than during fair-weather periods (Renaud et al., 1996, 1997); Schmid, 1996; Riggs, et al., 

1998; Wren and Leonard, 2004).  High-resolution seafloor bottom mapping and post-storm video 

obtained after extreme storms at inner and mid-shelf (< 30 m depth) sites within Onslow Bay 

have demonstrated significant changes in surficial sediment distribution, of which the authors 
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have attributed as a direct response to storm induced currents (Renaud et al., 1996; Riggs et al., 

1996; Renaud et al., 1997; Riggs et al., 1998; Thieler et al., 2001).  Several of these studies 

centered on storm events that were the largest magnitude on record for this region and may not 

be indicative of conditions associated with events that are more commonplace.  In each of these 

studies, bottom conditions associated with the events were based on short-term current meter 

moorings or estimated from hindcasted wave data obtained considerable distances from the 

actual location.  Thus, a true picture of the effects of storms on hydrodynamic conditions and 

sediment mobility in the near-bottom layer were still lacking until very recently. 

This present paper seeks to further refine knowledge of near-bottom hydrodynamic 

current conditions required to mobilize native sediments on a high-energy sediment starved shelf 

environment and to link these data to changes observed in repeat sidescan sonar surveys of the 

region.  Specifically, contributions from tidal and subtidal current flows, as well as wave-

generated oscillatory motions in the near-bottom region of the seabed during storm and non-

storm conditions have been identified and quantified for the nineteen-month period bracketing 

two tropical storm seasons off the North Carolina coast.  To further constrain the hydrodynamic 

conditions under which sediments are mobilized, associated meteorological surface conditions 

during periods of significant sediment mobility have been identified and grouped into a broad 

system of classification.  Sidescan sonar imagery will demonstrate that even the passage of weak 

tropical systems and high-energy winter storms (nor’easters) over this period have not effectively 

transported widely distributed, fine-grained bottom sediment across the seabed, even though 

hydrodynamic conditions warrant sediment redistribution.  Data presented in this paper stem 

from research conducted under the support of the Coastal Ocean Research and Monitoring 

Program (CORMP).  This multidisciplinary program of study investigates and monitors the 
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physical, geological, chemical, and biological processes occurring on the continental shelf in the 

South Atlantic Bight. 

STUDY AREA 

Onslow Bay is located off the coast of southeastern North Carolina (Fig. 1).  It is a broad, 

shallow embayment bounded to the northwest by Cape Lookout, to the southwest by Cape Fear, 

and eastward by the continental slope break located along the approximately 100 m depth 

contour.  The inner continental shelf location chosen for this study is positioned in water depths 

of 15-17 m approximately 8 km east of Masonboro Island, transgressive barrier island (Fig. 2).   

Seasonal Hydrodynamic and Meteorological Conditions in Onslow Bay  

Mean tidal range is approximately 1.0 m, placing the location in a microtidal setting as defined 

by Hayes (1979).  It is also a high-energy, wave-dominated environment yielding average 

significant wave heights, as calculated by an in-situ ADCP over the nineteen-month study 

period, of 0.9 m and average dominant wave periods of approximately 7.3 seconds.  These data 

agree well with other locally performed wave climate studies (Jarrett, 1977) and regionally 

calculated hindcast data (WIS research).  Wave approach at this location is seasonally dependent.  

In winter, the dominant wave approach is from the northeast, and in summer this direction 

typically reverses to the southeast.  Further, waves originating to the south as well as east are not 

uncommon, especially during the passage of tropical cyclones and extratropical storms (Thieler 

et al., 1995; Thieler et al., 2001).  

Surficial Lithofacies in Onslow Bay 

The OB3M study site (known locally as Five Mile Ledge) is located adjacent to a low-

relief rock outcrop in Onslow Bay, NC, at an average depth of approximately 17.7 m (Fig. 3).   
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Fig. 1.  Regional view of Onslow Bay and surrounding offshore waters. Onslow bay 
is bordered to the northeast by Lookout Shoals and Raleigh Bay and to the southwest 
by the Cape Fear Shoals and Long Bay.  Instrumentation deployed for this study w
located at OB3M.  Frying Pan Tower marks the NOAA C-Man station where wind 
data were collected.  The 100 m bathymetric contour (boldfaced) indicates locatio
the continental shelf break.  
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Fig. 2. Site map of Onslow Bay lower shoreface and inner continental shelf study 
area.  Ship track lines used for sidescan sonar survey are also provided.  Sidescan 
swaths cover 100 m on each side of the track lines and run northeast to southwest for 
approximately 5.5 km.  Bathymetry data for the immediate area surrounding  the 
OB3M instrument site (red box) is given in Fig. 4.  
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Fig. 3.  OB3M site bathymetry and sidescan sonar track lines.  Bathymetry is 
contoured using 0.25 m intervals and labeled every 1 m.  Sidescan swaths cover 100 m 
on each side of the track lines.  Approximate locations of the marine hardbottom reef 
ledge (red line) and ADCP instrument site (star) are also provided. 
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Exposed outcrops, commonly termed marine hardbottoms, are not uncommon in Onslow Bay as 

it is starved of major sediment input due to trapping of local riverine sediments in back barrier 

marshes (Blackwelder et al., 1982).  Further, it is isolated from adjacent embayments by two 

major capes and associated shoals, thereby limiting alongshore exchange of sediment 

(Blackwelder et al., 1982).  The modern unconsolidated sediments that do exist on the lower 

shoreface and inner-shelf seabed result from three major inputs.  The surficial sediment cover 

has been categorized as residual, ultimately resulting from the erosion of underlying relic 

sediments and rocks (Milliman et al., 1972).  Further, native sediments in this region have 

accumulated via shoreface bypassing of the underlying relict Oligocene aged unconsolidated 

sediments (Thieler et al., 2001) as well as through the physical and bio-erosion of exposed live 

reef hardbottoms prevalent across the lower shoreface and inner-shelf (Riggs et al., 1996; Thieler 

et al., 1995; Thieler et al., 2001).  Additionally, beach replenishment of nearby Wrightsville 

Beach has been identified by Pearson and Riggs (1981) and Thieler et al. (1999, 2001) to have 

exceeded natural limits, and this “extra” sediment has proceeded to leak offshore and be 

deposited onto portions of the lower shoreface and inner-shelf.  

Aside from the abundant marine hardbottoms, two distinct surficial lithofacies dominate 

the inner and mid-shelf landscape.  Poorly sorted gravelly sands exist as lag pavement in 

topographic depressions adjacent to higher relief hardbottom areas and ancient erosional scarps 

(Riggs et al., 1996; Riggs et al., 1998).  This gravelly coarse sand fraction is believed to be 

derived primarily from the bioerosion of numerous Plio-Pleistocene aged rock outcrops and 

biogenic material accompanying hardbottom reef areas (Thieler et al., 1995).  As described by 

Renaud et al. (1997) and Riggs et al. (1998), well-sorted fine sands comprise the second distinct 

bottom type and occur in four general locales within Onslow Bay.  The first two occurrences of 
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these fine sand areas are sand aprons and sand ramps immediately adjacent to the perimeter of 

hardbottom areas.  The third occurrence is away from the hardbottom, in what are known as the 

lower sand flats, where thin, discontinuous sheets bury the gravel-based sand dunes. Locally, the 

vertical breadth of these fine sand bodies has been measured to be extremely thin, averaging 30 

cm in most places (Thieler et al., 1995).  Lastly, thin veneers (< 5 - 25 cm) of very fine to silty 

sands that have been suspended and later redeposited within fractures or depressions among the 

flat hardbottom also occur (Riggs et al., 1998).  Fine sand bodies are hypothesized to primarily 

be a product of shoreface bypassing of underlying relict Oligocene units composed of silts to fine 

grained sands (Thieler, et al., 1995; Thieler et al., 2001).  A third transitional facies has also been 

identified at mid-shelf locales along the boundaries of the fine and gravelly coarse sand bodies 

where the sediment types intermix (Schmid, 1996). 

MATERIALS AND METHODS 

Data collection occurred from March 2002 through October 2003 (Table 1) and utilized 

two distinct methods of collection: 1) continuous hydrodynamic time-series data collected by 

moored instrument packages; and 2) sediment cores, grab samples and sidescan imagery 

collected periodically prior to and following significant storm events.  

Hydrodynamic Data Acquisition  

All hydrodynamic data were collected at the OB3M study site (34° 06.13 N, 77° 45.05 

W) shown in Figs. 2 & 3.  An aluminum cage moored to the seafloor via sand screws at OB3M 

housed a 1200 kHz RDI Workhorse Sentinel Broadband Acoustic Doppler Current Profiler 

(ADCP) initially deployed in spring 2002.  A crescent-shaped hardbottom with relief of 

approximately 1.5 m bounds the northern and western sides of the moored instrumentation at the 

OB3M study site, which sits approximately 30 m due west of the reef ledge.  Similar to the  
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Season Deployment Period Sidescan Survey Date 
Spring 2002 4/25 - 6/21 3/14/02 

Summer 2002 6/21 -7/10; 
7/24 -10/14 - 

Fall 2002 7/24 -10/14; 
10/29 -1/14 11/21/02 

Winter 2002-2003 10/29 -1/14; 
1/17 -4/11 - 

Spring 2003 1/17 - 4/11; 
4/20 - 7/11 5/30/03 

Summer 2003 4/20 - 7/11; 
7/20 -10/10 - 

Fall 2003 7/20 -10/10; 
10/24 -1/14 10/14/03 

Table 1.  Acoustic Doppler Current Profiler (ADCP) deployment dates for this 
study.  Also noted are sidescan sonar survey acquisition dates.  
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remainder of the gently sloping shelf of Onslow Bay, the bathymetry surrounding the 

instrumentation site is extremely gradual (Fig. 3).  

The upward looking ADCP collected current velocity data through the water column in 

0.70 m bins beginning at a height of 1.2 m off the seabed (mab) using a 2 Hz ping rate for 3600 

seconds (one ensemble) every 60 minutes.  The ADCP also possessed wave gauge capabilities 

that recorded wave period, significant wave height, average water depth to sensor, and 

significant wave direction.  Wave data were recorded at a 2 Hz ping rate for 1200 seconds every 

four hours.  Velocity time series data from the 1.2 m bin height above the bed were used when 

investigating near-bottom conditions and calculating bed shear velocity.  

The ADCP instrument was configured for deployment durations of 10 -12 weeks and was 

retrieved by divers utilizing SCUBA aboard the R/V Seahawk and R/V Cape Fear.  Typical turn 

around time between successive deployments averaged less than one week (Table 1).  Quality 

current data were retrieved on each of the deployments utilized for this study; however, wave 

data from the spring 2003 deployment are sporadic and inconsistent due to unknown reasons. 

Relative suspended sediment concentrations were estimated at a height of approximately 

1.2 mab using the raw acoustic backscatter signal (ABS) provided by the ADCP.  Calibration 

techniques and methodology supplied by the RDI company allow for an accurate estimation of 

the absolute backscatter in units of decibels to be calculated (Deines, 1999).  The ABS signal has 

been shown to be an acceptable proxy for estimating changes in suspended sediments and other 

particulate matter in the water column (Williams and Ross, 2001; Wren and Leonard, 2004).  

Sidescan Sonar Acquisition and Processing 

High-resolution sidescan sonar imagery was used to relate hydrodynamic conditions to 

seafloor geomorphology and analyze spatial changes in seafloor geomorphology due to high-
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energy events.  Four bi-annual sidescan sonar surveys centered upon the OB3M study region and 

covering an area of approximately 5.5 km by 3.7 km were conducted (Figs. 2 & 3).  These 

surveys took place March 2002, November 2002, May 2003, and October 2003 (Table 1).  The 

sidescan sonar data were collected with an EdgeTech DF1000 dual frequency digital towfish 

(100 and 500 kHz) using a range of 100m (200m swath width).   This study uses the sonar 

imagery collected by the 100kHz channels.  Twelve track lines were established in a north-south 

direction and bounded by the area 34° 07.26 N, 77° 45.47 W in the northwest and 34° 07.06 N, 

77° 44.10 W in the southeast. Track line spacing was 200 m to ensure maximum seafloor 

coverage (Fig. 3). For this study, navigation was collected from a Nobeltec differential global 

positioning system (DGPS) with an accuracy of ± 3-5 m.  Further error in navigation may result 

from uncertainty of the towfish position in the water column at any given time and resulted in a 

total navigational error between ±5-10 m during this study.  

The Isis Sonar v.6 software package distributed by Triton Elics International (TEI) was 

used for acquisition and processing of the sidescan sonar data.  A sonograph is a product of the 

intensity of acoustical backscatter, which is displayed as a gray-scale image with pixel values 

ranging from 0 to 255. In this study, a reversed gray-scale was used.  The highest backscatter 

intensities are displayed as 0 and lowest intensities as 255 (Fig. 4).  The TEI Isis software 

package was used to make geometric and radiometric corrections during the processing of the 

raw acoustic data on a line-by-line basis.  Individual lines were visually inspected and enhanced 

using the time varying gain (TVG), balance, and bottom track options to remove errors due to 

slant range, striping, beam pattern, and other effects degrading the image.  Lines were processed 

at a base resolution of 0.25 x 0.25 m per pixel and then exported into the TEI Delphmap software 

package where they were mosaicked and georeferenced.  Finally, the mosaics were fused into a  
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Fig. 4.  Sidescan mosaic of the regional area surrounding the OB3M study site acquired 
March 2002 using the 100 kHz frequency channels.  Pixel resolution is 0.25 x 0.25 m. Areas 
of high backscatter are displayed as dark returns and areas of low backscatter are observed 
as light returns.  Grey-black lines trending northeast to southwest are the nadir region 
directly below ship track line corresponding to those given in Fig. 3.  Marine hardbottom 
reef ledge is outlined in blue.  The boxed area is enlarged in Fig. 6 and highlights surficial 
lithofacies common to the study area. Coordinates are eastings and northings and units are 
given in meters.  
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geographic information system (GIS) database using the ESRI ArcView 3.2 software package 

where the sidescan mosaic imagery could be further analyzed.  Specific acquisition and 

processing parameters can be found in Appendix B.  

Geological Data Acquisition 

More than 40 boxcores were collected by divers utilizing SCUBA/NITROX under fair-

weather conditions and after the occurrence of significant high-energy events within 30 m of the 

CORMP instrumentation cage. The cores, which penetrate the seafloor to a depth of 

approximately 30 cm, provide evidence of erosional and depositional sedimentary structures.  

Cores were sub-sampled at the core surface, approximately 5, 10, and 20 cm downcore for grain 

size analysis.  Grain size characteristics were quantified using standard sieve techniques at one 

phi intervals.  Relief peels, x-ray photographs, and digital photographs constructed from 

sediment cores were used to further describe broad scale external and internal sedimentary 

structure and bedding after techniques described by Beavers (1999).  Over 30 surface grab 

samples were also collected and extensive visual observations were made pre- and post-sidescan 

surveys and during ADCP deployment and recovery to provide groundtruth for the sidescan 

sonar imagery.  

RESULTS 

Distribution and Characteristics of Surficial Sediments 

The patchy, discontinuous placement of surface sediments across the inner-shelf seabed 

is well illustrated in a regional sidescan sonar mosaic image centered on the OB3M study site. 

Overall, the distribution of the major surficial sediment types is highly variable and is reflective 

of the limited availability of unconsolidated sediment (Fig. 4).  In the immediate area 
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surrounding the OB3M site, mean grain size of the sediment ranges from 0.6 to 1.8 mm and 

composition is dominated by quartz, carbonate shell material, and small lithoclasts derived from 

the adjacent marine hardbottom area.  A generalized bottom type map of the regional area 

surrounding the OB3M site and nearby marine hardbottom reef is given in Fig. 5 and illustrates 

the distribution pattern of the two major surfical lithofacies based on differences in mean grain 

size and sidescan sonar reflectivity patterns.  

 In the sidescan imagery, areas where gravelly coarse sands occupy the surface are 

delineated by regions of high backscatter, which are typically dark grey to black and have  

a striated appearance representing the megaripple type bedforms, which top them (Figs. 4 & 6). 

These poorly sorted sands are distinguished by the presence of long, straight megaripples, with 

measured wavelengths of 0.75 m and amplitudes of roughly 0.12 m and are believed to become 

mobilized under enhanced hydrodynamic conditions during storms (Thieler et al, 2001).  In the 

immediate region surrounding the OB3M site, mean grain size of the coarse sands ranges from 

0.6 to 1.8 mm, and composition is dominated by quartz, carbonate shell material, and small 

lithoclasts derived from adjacent marine hardbottom areas (Fig. 7).    

Nearby areas of fine sands on the lower sand flat and atop the marine hardbottom are 

interpreted in sidescan imagery to be homogeneous areas of low backscatter, which typically 

appear as light grey to white in imagery mosaics (Figs. 4 & 6). Fine sands comprising also the 

lower sand flats adjacent to the OB3M instrumentation site exhibit a mean grain size between 

0.19 - 0.22 mm and are well sorted, except for occasional shell fragments.  Active three-

dimensional ripples on the fine sand areas of the lower sand flats had wavelengths between 10 -

13 cm and amplitudes of roughly 5 cm as recorded by divers under fair-weather conditions (Fig. 

8).  
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Fig. 5.  Generalized bottom type map of OB3M inner-shelf study site corresponding to 
mosaic imagery provided in Fig. 4.  Broad scale interpretation is based upon diver 
collected surface grab samples and sidescan sonar mosaic reflectivity patterns. 
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Fig. 6.  Sidescan image of marine hardbottom reef area and lower sand flat displaying 
dominant lithofacies at the inner-shelf site.  A = fine sand veneer atop hardbottom, B = 
exposed hardbottom with little to no sediment cover, C = reef ledge with adjacent fine sand 
sheet below, D = fine sand sheets overlying coarse gravelly sands demonstrating well-
defined contact, E = sidescan sonar nadir, F = modern gravelly coarse sand composed of 
megaripples oriented to storm wave approach,  G = area where fine sand sheet has been 
deposited over the pavement lag coarse sand as evidenced by long wavelength ripples 
showing through.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 17



 

A.  

B.  

Fig. 7.  Digital photographs of gravelly coarse sand sediment type positioned 
on the lower sand flat.  Note the well-defined symmetric megaripples (λ = 
0.75 m, η = 0.12 m) generated by wave oscillatory flows.     
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B.  

A.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 8.  Digital photographs of well-sorted fine sand sediment type located on 
lower sand flat.  Ripple dimensions at the time of observation were λ = 0.10 - 
0.13 m, η = 0.05 m.  
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Seasonal Averages of Hydrodynamic and Meteorological Data  

For the purposes of this paper, seasons were defined to be consistent with the classic 

astronomical concept following the path of the earth along the ecliptic. Using this designation, 

June 21, the summer solstice, is assigned the first day of summer and December 21, the winter 

solstice, the first day of winter in the northern hemisphere.  Spring thus begins on March 21, and 

fall on September 21, as these dates occur on the spring and autumnal equinoxes respectively.  

From April 2002 through October 2003, which is the extent of our hydrodynamic data covering 

the period of repeat sidescan sonar surveys, the average current magnitude 1.2 m above the 

seabed (mab) at the OB3 site was 5.8 cm s-1 and directed predominately from the south-southeast 

to the north-northwest across the inner-shelf.   Mean current magnitudes varied little with season 

ranging from a low of 5.1 to a maximum of 6.4 cm s-1.  Maximum near-bottom current 

magnitudes were 26.1 cm s-1 and occurred during the offshore passage of Hurricane Isabel in 

September 2003.  For all data collected, the mean current speed at 1.2 mab in the along-shelf 

direction was -0.20 cm s-1 from SW to NE and the mean across-shelf current speed was -1.9 cm 

s-1 in the onshore direction.  For this study, positive along-shelf is defined as being directed from 

the northeast to the southwest and positive across-shelf is defined as being directed offshore.  

The maximum across-shelf speed for all deployments was -22.0 cm s-1, which is directed onshore 

and maximum along-shelf speed was -23.8 cm s-1, which is directed from southwest to northeast 

(Table 2).  

The dominant wind direction during the nineteen-month period, as measured at Frying 

Pan Tower (FPT), was directed out of the southwest at 174 degrees and the average wind speed 

was 15.9 knots.  The maximum recorded wind speed during this study was 62 knots and this 

occurred during the passage of Hurricane Isabel in September 2003.  The average wave height at  
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Table 2.  Seasonal near-bottom current flow data measured at 1.22 m above the bed (mab).  
Seasons are defined following the classic astronomical concept based on the earth’s position 
along the ecliptic. *Data gaps occur during routine maintenance of instrumentation.  All 
measurements are in cm s-1.  Positive along-shelf is directed to the southwest and positive 
across-shelf is directed offshore. 
 Summer 
2002 
6/21 - 
9/20 

Fall 
2002 

9/21 - 12/20 

Winter 
2002-03 

12/21 - 3/20 

Spring 
2003 

3/21 - 6/20 

Summer 
2003 

6/21 - 9/20 

Fall 
2003 
9/21 -
12/20 

All Data
4/25/02 - 
1/13/04* 

Mean 
Current 6.38 5.8 5.54 5.91 5.05 5.83 5.82 

Maximum 
Current 19.1 19.8 19.5 25.6 26.1 23.3 26.1 

Mean 
Along-shelf 

velocity 

-0.67 
NE 

0.6 
SW 

-0.09 
NE 

-0.30 
NE 

0.53 
SW 

-0.25 
NE 

-0.20 
NE 

Mean 
Across-shelf 

velocity 
-1.39 

onshore 
-1.4 

onshore 
-2.34 

onshore 
-2.77 

onshore 
-1.62 

onshore 
-1.61 

onshore 
-1.91 

onshore 

Maximum 
Along- shelf 

velocity 

-16.58 
NE 

-17.3 
NE 

-16.96 
NE 

-23.32 
NE 

-23.8 
NE 

15.89 
NE 

-23.8 
NE 

Maximum 
Across-shelf 

velocity 
-17.09 
onshore 

-19.1 
onshore 

-17.04 
onshore 

-21.54 
onshore 

-22.00 
onshore 

-21.22 
onshore 

-22.00 
onshore 

Maximum 
Semidiurnal 

Tidal Current 
4.90 3.4 3.77 4.42 3.37 3.63 4.90 
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the 5-mile study site, recorded by the ADCP, was 0.9 m and the average wave period was 7.3 

seconds.  The largest significant wave height on record was 2.6 m and occurred during the fall of 

2003.  Average seasonal near-bottom wave orbital velocities ranged from 7.9 cm s-1 to 11.4 cm s-

1 with an overall study period mean of 9.8 cm s-1.  The maximum wave orbital velocity on record 

was 63.9 cm s-1, again during the passage of Hurricane Isabel (Table 3).  

Determination of Sediment Mobility  

The Styles and Glenn (2002) bottom boundary layer model was used in this study to 

calculate bed shear stress and critical shear velocities due to both currents and the combined 

effects of waves and currents at the seabed.  This model is an update of the 1987 Glenn and 

Grant continental shelf boundary layer model commonly used to determine flow and suspended 

sediment concentration profiles in the boundary layer overlying a non-cohesive, sand-dominated 

seabed.  The new model version includes a stratification correction, which when field tested off 

the New Jersey coast, was demonstrated to be significantly better at predicting sediment 

transport, especially during storm events (Styles, 2000). 

 The model required the input of several parameters including time series data of the mean 

current (ur) at a chosen reference elevation (Zr) within the lower 1.2 mab, time series data of 

near-bottom wave orbital velocity (ub) and wave excursion amplitude (Ab), both calculated using 

linear wave theory equations.  Both the current time series data and wave data used to calculate 

wave orbital velocity were obtained from the ADCP at four hour intervals. The model also 

required the input of grain size distributions based on the surficial sediments prevalent at the 

study site as well as a default for ripple characteristics, and wave and current incidence angle.  

These input parameters were obtained through diver observations during standard instrument 

deployment and retrieval cruises at the OB3M site.  
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Table 3.  Seasonal significant wave and acoustic backscatter signal (ABS) data obtained from 
the OB3M study site via an ADCP moored on the inner shelf (17.7 m depth). ABS signal is 
from the 1.22 m bin elevation above the seabed. For comparative purposes, data denoted in 
parentheses is from a mid-shelf (30 m depth) wave gauge approximately 64 km southeast of 
OB3M.  Hs = significant wave height  and ub = near-bottom wave orbital velocity. 

 

 

 
 

Summer 
2002 

6/21 - 9/20 

Fall 
2002 

9/21 - 12/20

Winter 
2002-03 

12/21 - 3/20

Spring 
2003 

3/21 - 6/20

Summer 
2003 

6/21 -9/20 

Fall 
2003 

9/21 -12/20 

All Data 
5/4/02 - 
1/13/04 
(5/1/02 - 
1/31/04) 

Mean ABS 
(dB) 58.81 60.46 60.29 59.86 60.39 60.68 59.89 

Maximum 
ABS 
(dB) 

68.89 78.9 70.54 69.71 72.6 71.78 78.9 

Mean Hs 
(m) 

0.9 
(1.1) 

1.0 
(1.3) 

1.0 
(1.5) 

0.9 
(1.3) 

0.9 
(1.3) 

1.0 
(1.5) 

0.9 
(1.33) 

Maximum Hs
(m) 

2.1 
(3.3) 

2.2 
(4.5) 

2.1 
(4.5) 

2.1 
(3.5) 

2.5 
(6.0) 

2.6 
(5.1) 

2.59 
(6.0) 

Mean Period 
(sec) 

6.9 
(7.3) 

7.2 
(7.7) 

6.8 
(7.5) 

6.9 
(7.5) 

7.6 
(8.0) 

7.5 
(7.9) 

7.3 
(7.6) 

Maximum 
Period 
(sec) 

18.2 
(16.7) 

16.0 
(14.3) 

14.2 
(14.3) 

12.8 
(12.5) 

18.2 
(20.0) 

18.2 
(16.7) 

18.2 
(20) 

ub Mean 
(cm s-1) 

7.9 
(10.4) 

10.0 
(15.3) 

9.5 
(16.5) 

8.8 
(14.3) 

11.2 
(18.6) 

11.4 
(16.9) 

9.8 
(14.9) 

ub Maximum 
(cm s-1) 

37.5 
(61.4) 

33.4 
(77.2) 

42.9 
(84.5) 

28.1 
(59.4) 

63.9 
(149.5) 

39.1 
(94.3) 

63.9 
(149.5) 
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 The model output provided time series data of bed stresses in response to near-bottom 

currents and the combined effects of waves and currents at the seabed.  These data were 

computed for each season of the study period as well as for individual sediment mobility events 

hypothesized to be influential in mobilizing significant sediment amounts.  Critical shear stress 

was calculated using the median grain size from surficial grab samples of fine sand bodies on the 

lower sand flat adjacent to the instrument site and critical shear velocity for the initiation of 

motion was provided in the model output.  Similar to methods employed by Wren and Leonard 

(2004), a critical shear velocity for incipient suspension was calculated using the Rouse 

parameter (Middleton, 1984) for the median grain size within the fine sand bodies at the site 

(0.2041 mm) and was determined to be 2.46 cm s-1.  The required critical shear velocity for full 

suspension of sediment was also calculated using the Rouse parameter and determined to be 6.16 

cm s-1.  

Tidal Currents  

Harmonic analysis of the current time-series data collected 1.2 mab indicates that the 

dominant tidal frequency is the M2 semidiurnal constituent.  This result agrees well with 

previous studies, which have shown that greater than 80% of the tidal energy present in the upper 

water column of Onslow Bay is controlled by the M2 tidal component (Pietrafesa et al., 1985). 

Tidal ellipse calculations at 1.2 mab yielded a major axis value of 3.1 cm s-1 and minor axis 

value of 0.37 cm s-1.  Orientation of the ellipse is 11.7 degrees north of east.  A band-pass filter 

set at 10 - 16 h similar to Wright et al. (1999) was employed to separate semi-diurnal tidal 

currents in the near-bottom layer from remaining mean current flows. Near-bottom tidal currents 

at the 1.2 m elevation were consistently between 3.0 to 4.9 cm s-1 and showed little variability 

between neap and spring tidal cycles.  To better constrain the potential effects of tidal currents on 
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sediment mobility periods of fair-weather (light winds and calm sea state) were identified and 

examined.  This approach minimized the effects of other dominant physical forcing mechanisms, 

which may contribute to significant sediment mobility. 

One such period was between July 2003 and September 2003 when a large area of high 

pressure dominated the region across Onslow Bay.  Winds during this period averaged 13.2 

knots and prevailed from the south, while average wave heights were generally below the long-

term average of 0.9 m.  During this period of fair-weather mean bottom tidal currents at 1.2 mab 

was 3.4 cm s-1 with a maximum of only 4.8 cm s-1.  Shear velocity due solely to currents (u*c), 

assumed to be dominated by tides, did not exceed 0.25 cm s-1.  This is well below the calculated 

critical shear velocity of 1.33 cm s-1 needed to initiate movement of fine grain sediments typical 

of the study area.  

Waves and Wind-driven Currents  

Near-bottom wave orbital velocity was calculated using four hour wave height and period 

data obtained from the inner-shelf ADCP and applying standard linear wave theory equations. 

The average near-bottom wave orbital velocity for the entire study period was 9.8 cm s-1 with 

seasonal values ranging from 7.9 cm s-1 to 11.4 cm s-1.  Near-bottom wave orbital velocity was 

calculated using four hour wave height and period data obtained from the inner-shelf ADCP and 

applying standard linear wave theory equations.  The maximum wave orbital velocity on record 

was 63.9 cm s-1 and occurred during Hurricane Isabel, which passed approximately 225 km 

offshore of the study area (Table 3).  

The stress imparted to the seabed by wave-current interaction is several orders of 

magnitude greater than that of currents alone during a period of quiescent weather dominated by 

light winds and average to below average wave conditions.  A simple correlation analysis 
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comparing the ABS signal at 1.2 mab (our proxy for suspended sediment within the water 

column) and near-bottom wave orbital velocity for all data collected, indicates a high degree of 

correlation (r = 0.45).  Employing the critical threshold for initiation of sediment movement 

under the influence of waves and currents during the nineteen month period, it was calculated 

that the fine sand portion of the seabed was inactive less than 34% of the time.  

The subtidal current contribution to the mean near-bottom current was obtained by 

applying a 33 h low-pass filter similar to Wright et al., (1999).  Along-shelf and across-shelf 

subtidal current component flows were rotated parallel and perpendicular to the NE to SW 

trending coastline respectively, to aid in determining direction of transport during periods of 

elevated sediment mobility.  The bulk of the low frequency signal is considered the product of 

surface winds and compares well with intensity and direction of local surface winds.  Subtidal 

current direction, as well as the overall mean current at the 1.2 mab compared well with surface 

wind direction particularly in the along-shelf direction, and often responded rapidly to reversals 

in winds aligned in the along-shelf direction (Fig. 9).  During this event, winds associated with 

an offshore area of low pressure remained directed out of the north-northeast at speeds above 15 

knots for more than 72 hours before subsiding and switching to the south-southwest as the low 

pressure area departed to the north.  The along-shelf component of the subtidal current responded 

accordingly and became directed to the southwest during this period.  The weaker across-shelf 

subtidal component also responded to wind-driven flow reversals throughout the study; however, 

the relationship with wind direction and intensity was less developed. 

Maximum subtidal current velocities ranging between 5.2 and 15.1 1 cm s-1 occurred 

during high-energy wind events (i.e. low pressure storm systems and frontal passages).  The peak 

value measured for subtidal currents was 19.7 cm s-1 and was recorded during the passage of  
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NORTH 

SOUTH 

Fig. 9.  Time-series of burst averaged parameters demonstrating subtidal 
current response at 1.22 mab from May 20 - 25, 2002, a significant event.  
(A, B) Wind speed and direction data obtained from Frying Pan Tower 
(FPT) C-Man station. (C) Subtidal along-shelf (solid) and across-shelf 
(dashed) component flows.  Positive along-shelf is defined as being 
directed to the southwest and positive across-shelf is directed offshore.  
Dates are given in coordinated universal time (UTC) beginning at 0000 
UTC. 
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Hurricane Isabel when winds remained elevated above 34 knots for more than 30 hours and 

exceeded 50 knots for more than 17 hours.  Relative to the input by wave orbital velocities, 

subtidal currents were rather weak and rarely exceeded 10 cm s-1.  Wave orbital velocities, on the 

other hand, readily exceeded 20 cm s-1 for eighteen of the twenty three events.  Factoring in 

waves and accounting for the synergistic effects of wave-current interaction, critical shear 

velocity due to waves and currents (u*cw) exceeded critical thresholds for movement of the fine 

sand fraction of the seabed 66% of the time.  Incipient suspended load was the primary means of 

mobility occurring 48.9% of the time, while movement solely as bedload took place 16.6% of the 

time.  Full suspension of fine sand sediment was found to occur for less than 1% of the recorded 

period. 

For all currents at 1.2 mab during the period of study, shear velocity due to solely to 

currents (u*c) rarely exceeded critical values required for mobilization of fine sand found at the 

site.  Bottom boundary layer model output indicated that only 53 instances of out of 3320 total 

data points surpassed the threshold for movement.  This equates to less than 1.6% of the total 

study period.  Further 15% of these sediment mobility events occurred during a sixteen day 

period in September 2003 when Tropical Storm Henri and Hurricane Isabel impacted the region 

and initiated strong subtidal flows. 

High-energy Events Responsible for Sediment Mobility 

 
Distinct sediment mobility events were identified using the acoustic backscatter signal 

(ABS) from the 1.2 elevation bin of the ADCP as a proxy for suspended sediment in the near-

bottom zone.  The criteria for identifying significant resuspension events was defined as those 

where the ABS signal exceeded 1.5 standard deviation of the average ABS at the 1.2 m elevation 

for a minimum of six consecutive hours.  A total of twenty-three high-energy sediment mobility 
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events were identified (Appendix A).  Current and wave data from the ADCP, and archived 

meteorological data from an offshore NOAA C-Man station (FPT) for the periods corresponding 

to these events, were then reviewed to determine the nature of the event. 

 Events were grouped into a broad classification system based on observed wind and 

atmospheric pressure data obtained from the Frying Pan Tower C-Man Station (Fig. 1), and 

through analysis of archived surface weather maps provided by the National Center for 

Environmental Prediction (NCEP).  In this classification system, tropical systems were first 

delineated from extratropical events.  These include tropical depressions, tropical storms, and 

hurricanes. Of the twenty-three events identified, four were tropical, with one becoming a major 

hurricane during the summer of 2003. The remaining nineteen events generated outside of the 

tropics were given the designation as extratropical due to genesis outside the tropics.  These 

episodes were subclassed based on three general differentiating characteristics and anticipated 

sediment transport potential.  The three classes were defined as, (1) defined areas of low pressure 

with at least one closed isobar affecting the region (strongest types labeled as nor’easters), (2) air 

mass frontal boundaries that generally approach from the west and south and may linger as 

stationary fronts for extended periods and are not associated with a local area of low pressure, 

and (3) fair-weather southerly wind events associated with high pressure conditions.  All three 

classes were associated with above average sea-state, while the two former were also 

characterized by unsettled atmospheric conditions connected with storms.  Depending on track 

and intensity, tropical events were associated with atmospheric conditions ranging from fair to 

windy and rainy, but always involve an elevated sea state, while southerly wind events tend to 

occur only under fair-weather.  It is evident that different combinations of event type, intensity, 

track, and duration do occur and result in a dynamic range of atmospheric conditions.  This 
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system of classification is by no means definitive and was constructed to help constrain the 

physical processes in the near-bottom zone resulting from atmospheric forcing. 

The distinct sediment mobility vents spanned the nineteen-month period and occurred in 

higher frequency during the fall, winter, and spring months.  Several were minor sediment 

mobility events.  Thirty-nine percent narrowly met the six-hour criteria for mobilization lasting 

between six and twelve hours, while approximately 71% were sustained over periods of several 

hours to days.  Seven events occurred in the spring, whereas fall and winter experienced six and 

five significant sediment mobility events, respectively, as outlined by study criteria.  Only four 

events occurred in the summer months; however, three of the largest events on record took place 

during the last two weeks of the 2002 and 2003 summer seasons and all were tropical born.   

Four sets of field data are presented below to illustrate near-bed response to changing 

surface conditions and to represent different levels of sediment mobility event intensity as well 

as the four major types of atmospheric conditions.  These episodes are highlighted based on their 

predicted potential for mobilizing sediment and are as follows: (1) a late spring southerly wind 

event; (2) a fast moving nor’easter with associated cold front passage; (3) a slow moving, wind-

dominated tropical storm event; and finally (4) a strong summer hurricane characterized by large 

ocean swells and high intensity winds (Table 4).  

Southerly Wind Event: June 6 - 11, 2003 

In the days leading up to this event, winds veered from the north to southeast direction 

following the passage of a moderate cold front across Onslow Bay waters.  As the Bermuda high 

pressure expanded over offshore waters, its clockwise circulation produced moderate winds from 

the southerly direction for the 72 h period beginning at 0000 UTC on June 7. Winds ranged from 

less than 8 - 29 knots over this time.  Wave heights at the inner-shelf study site rose slightly  
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Event Type Winds  
(knots) 

Hs 

(m) 
Tp

(sec) 
ub

(cm s-1) 

Mean  
current 
(cm s-1) 

Subtidal 
current 
(cm s-1) 

u*c

(cm s-1) 
u*cw 

(cm s-1)

1. 6/7/03 - 6/10/03 Southerly Wind Event 
(BH) 

10-30 
SE-SW 0.7 - 1.6 6 - 9 4.0 - 23.4 0.7 - 14.1 1.4 - 10.9 0.3 - 1.2 1.9 - 5.1 

2. 12/25/03 - 12/27/03 Extratropical Low 
 (ETlo) 

10-50 
SE-NW 0.6 - 1.8 6 - 9 6.0 - 24.2 0.7 - 17.1 4.1 - 14.8 0.2 - 1.5 2.6 - 5.0 

3. 9/8/03 - 9/13/03 Tropical Storm  
(T) 

10-40 
NE-NW-

NE 
0.5 - 2.0 5 -10 1.7 - 37.5 1.8 - 13.8 2.8 - 9.8 0.2 - 1.3 1.3 - 6.4 

4. 9/15/03 - 9/20/03 Hurricane  
(T) 

10-60 
SE-N-SW 1.0 - 2.5 5 -18 1.2 - 63.9 0.2 - 26.1 1.9 - 19.7 0.2 - 2.1 1.1 - 8.6 

Table 4.  Summary of four major sediment mobility events observed between April 25, 2002 and October 14, 2003.  Event 1) 
Subtropical Storm Gustav, 2) December extratropical low passage, 3) June southerly wind event, and 4) offshore passage of 
Hurricane Isabel.  Currents are given at 1.2 mab.   

 

 

 

 

 

 



 

during the initial wind shift to the south, from less than 1.0 m to greater than 1.5 m, at 0000 UTC 

on June 8 before slowly subsiding back to ambient fair-weather conditions by 1200 UTC on the 

8th.  A secondary peak occurred on June 9 in response to a slightly intensified wind field (Fig. 

10C). 

Mean current magnitude at 1.2 mab ranged from less than 1.0 to 14.7 cm s-1 and was 

partially influenced by the semidiurnal tidal component input as demonstrated by the cyclic 

nature of the flow regime. As tidal currents moved in conjunction with the mean flow, currents 

increased in magnitude, and when they moved in the opposite direction the mean current was 

diminished.  Overall, during the first 36 h of this event, the mean current flowed in the negative 

across-shelf direction and oscillated between the positive and negative along-shelf direction 

indicating a net motion in the onshore direction (Fig. 10A).  The magnitude of subtidal flows 

displayed a consistent rise over the same period from 1.4 cm s-1 to 10.9 cm s-1 in response to 

sustained winds of approximately 20 knots out of the south and follows the direction of the mean 

component flows at the same depth (Fig. 10B).  Waves approached from the south-southeast 

throughout the duration of the event and associated wave orbital velocities in the near-bed layer 

ranged from 4.0 to 23.4 cm s-1 with more than 36 consecutive hours of the velocity exceeding 

10.0 cm s-1 between June 7 and June 9 (Fig. 10E).   

 During the 12 hour period bracketing 1200 UTC June 7 and 0000 UTC June 8, a sharp 

rise in the acoustic backscatter signal at the 1.2 mab occurred (Fig. 10G), and remained elevated 

for the remainder of the sediment mobility event. It is fair to say that in conjunction with 

moderate, slowly varying winds from the southerly direction and above average wave orbital 

velocities, that sediment was indeed being mobilized during this high-energy, yet fair-weather 

period.  Calculated shear velocities due to the synergistic effects of waves and currents (u*cw) 
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also favored sediment mobilization during this time.  For a 72 h period, u*cw values remained 

above 1.33 cm s-1 insuring, at the very least, that the fine-grained sand fraction of surficial seabed 

material would be mobilized as bedload.  Further, the combined wave-current shear velocity 

exceeded the 2.46 cm s-1 value needed for incipient suspension for 60 of the 72 hours defined in 

this event (Fig. 10F).  Together this evidence suggests a moderate sediment mobilization event 

even though high pressure and fair-weather conditions dominated the inner-shelf surface waters.  

 In terms of transport for this event, subtidal flows driven by the slowly varying surface 

wind pattern became directed in the negative across-shelf direction during the period of 

maximum conditions, at the same time, waves approaching the coast from south-southeast 

caused fine sand bedload migration to the north in the along-shelf and onshore.  Once incipient 

suspended load conditions were exceeded, the weak (7 to 10 cm s-1) subtidal flows had greater 

potential to transport the episodically suspended materials in the onshore direction in 

combination with contributions from wave oscillatory motions.  This scenario favors transport of 

significant amounts of previously mobilized sediment both onshore and to the north in response 

to the combined effects of subtidal currents and waves (Fig. 10). 

Extratropical Low and Frontal Passage: December 23 - 28, 2002 

 On December 24, 2002 an extratropical cyclone and trailing cold front 

approached the coastal waters of southeastern North Carolina from the west.  Ahead of the cold 

front, south-southwest winds increased in intensity from approximately 7 knots at 0900 UTC 

December 25 to more than 45 knots by 1600 UTC and remained elevated above 30 knots from 

the southwest through 0400 UTC on December 26.  At this point, the cold front passed offshore 

of the FPT NOAA C-Man Station and winds abruptly veered to the west-northwest while 

remaining sustained above 20 knots for 12 successive hours from this new direction.  Wave  
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Fig. 10.  Southerly wind event sediment mobility evidence. (A) mean along 
(solid) and across-shelf (dashed) current at 1.22 mab, (B) subtidal along (solid) 
and across-shelf (dashed) current at 1.22 mab, (C) significant wave height, (D) 
dominant wave direction, (E) near-bottom wave orbital velocity, (F) shear 
velocity due to currents (asterisk) and shear velocity due to waves and currents 
(star),  and (G) acoustic backscatter signal at 1.2 mab. Positive along-shelf is 
defined as being directed to the southwest and positive across-shelf is directed 
offshore.  Dates given are in coordinated universal time (UTC) beginning at 
0000 UTC.  Paired vertical lines outline duration of event. 
 



 

heights during this period, ranged from 1.0 to1.75 m through 1800 UTC on December 25, and 

slowly subsided to below 1.0 m as winds turned to the west-northwest after passage of the cold 

front.  Wave direction maintained a south-southeast approach and wave period remained 

consistent between 6 - 9 seconds throughout the entire 48 period of interest (Figs. 11C, D). 

Mean currents were initially quite weak remaining less than 10 cm s-1 for the first 25 

hours as surface winds steadily increased in velocity from the south-southwest.  By 0000 UTC 

on December 26 mean current magnitude topped 10 cm s-1 and averaged 13.2 cm s-1 for the next 

17 hours, even as surface winds subsided to ambient conditions.  Subtidal current magnitude 

followed suit ranging from 10 to 15 cm s-1 during the same period.  Although missing a portion 

of data for the period, the trend in wave orbital velocity follows that of the maximum winds and 

ranges from 9.9 to 24.2 cm s-1 from 1200 UTC on December 25 through 1600 UTC on December 

26.  Following this peak in wave orbital velocity, a peak in acoustic backscatter signal in the 

near-bottom layer followed several hours later and exceeded criteria levels for eleven successive 

hours indicating sediment suspension during this period through at least the lowest 1.2 m of the 

water column (Fig. 11E, G).  Further, shear velocity, u*cw, exceeded the critical value for fine 

sands thereby enabling incipient suspension for the entire forty eight hour event, nonetheless 

shear velocities never reached levels permitting full suspension of fine grain sand bottom 

sediments (Fig. 11F).   

 Subtidal currents responded to the changing surface wind regime, which potentially 

affected the transport path of mobilized sediment that had become suspended (Fig. 11B).  As 

indicated by the shear velocity calculation, bottom sediments contained in the fine sand bodies 

would have been, at the very least, mobilized as transitional bedload throughout the entire event.  

Initially, fine-grained sands momentarily suspended would be directed along-shelf in the  
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Fig. 11.  Evidence for sediment mobility from December 25, 2002 extratropical 
low. (A) mean along (solid) and across-shelf (dashed) current at 1.22 mab, (B) 
subtidal along (solid) and across-shelf (dashed) current at 1.22 mab, (C) 
significant wave height, (D) dominant wave direction, (E) near-bottom wave 
orbital velocity, (F) shear velocity due to currents (asterisk) and shear velocity 
due to waves and currents (star), and (G) acoustic backscatter signal at 1.2 mab. 
Positive along-shelf is defined as being directed to the southwest and positive 
across-shelf is directed offshore.  Dates given are in coordinated universal time 
(UTC) beginning at 0000 UTC.  Paired vertical lines outline duration of event. 
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southwest to northeast direction with very little onshore or offshore movement.  This would have 

occurred prior to the frontal passage when winds were directed from the south and southwest.  

After the wind switch to the NW, and coincident with the period of highest ABS signal at 0800 

UTC, the subtidal current component abruptly increased to more than 15 cm s-1 in the negative, 

which would favor driving suspended sediments in the onshore direction.  The along-shelf 

component remains negligible ranging from 0 to -5 cm s-1, which would direct currents to the 

southwest.  More importantly, the across-shelf component rapidly increases to more than 15 cm 

s-1 in the negative, which would favor driving suspended sediments in the onshore direction.  

Simultaneously, sediment is still in part being moved to the north as bedload by waves 

approaching from the south (Fig. 11D).  Again, this scenario suggests that the primary direction 

of transport under the maximum conditions of this event was in the onshore direction in the 

across-shelf and to the north-northeast in the along-shelf.  

Tropical Storm Gustav: September 7 - 12, 2002 

Tropical storm Gustav developed approximately 725 km south-southeast of Cape 

Hatteras under a deep upper level trough on September 8, 2002.  Gustav was unique in that it 

originated as a subtropical storm, but later developed tropical characteristics.  Further, the 

duration of Gustav was much longer than most tropical systems, which normally move rapidly 

through the region. This system moved slowly to the north and northeast off the North Carolina 

coast for more than two days.  Accordingly, it is considered representative of both a moderate 

nor’easter type storm and moderate intensity tropical system, both being common high-energy 

events that frequent the southeast U.S. coast in late summer and early fall seasons.   

Beginning at 0000 UTC on September 9, winds at the NOAA Frying Pan Tower (FPT) 

C-Man station began to increase steadily from 20 knots to more than 30 knots from the east-
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northeast direction indicating the advance of Tropical Storm Gustav.  Simultaneously, 

increasingly higher period waves (Tp = 8-10 s) began approaching from the same direction (Fig. 

12C).   Winds reached a peak velocity of just over 40 knots from  

the north early on September 10 and then slowly veered to the west-northwest and subsided to 

less than 20 knots by 1200 UTC on September 11 as Gustav began to move quickly off to the 

northeast.  Wave heights remained between 1.6 and 2.0 m during the twenty-four hour period 

between 1200 UTC September 9 and 1200 UTC September 10 and quickly subsided after this 

point (Fig. 12D).    

Mean currents in the near-bottom ranged from 1.8 to 13.8 cm s-1, reaching a maximum at 

1200 UTC on September 11.  These currents were initially dominated by the semidiurnal tidal 

component as evidenced by the well-defined periodicity in both the along- and across-shelf 

component (Fig. 12A).  As winds increased in intensity from the east-northeast on September 9, 

the mean current flow responded and became directed to the southwest.  This response is also 

evident in the subtidal flow regime, which here is assumed to be a direct product of the surface 

wind field.  Subtidal flows during this event reached a maximum of only 9.8 cm sec-1.  The 

along-shelf component flow was directed to the southwest at less than 10 cm s-1 for the duration of 

the event.  The flow quickly changed to the northeast direction early on September 11 as the 

winds switched from the northerly direction to the southwest direction (Fig. 12B).  The across-

shelf subtidal component remained very weak throughout the event and did not exceed 5 cm sec-

1.   

A coincident peak in wave orbital velocity and ABS signal occurred between 1300 UTC 

on September 9 and 2300 UTC on September10.  For the next 34 h, ABS remained above criteria 

levels and wave orbital velocity increased from ambient levels (< 10 cm s-1) to more than 37 cm  
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Fig. 12.  Tropical Storm Gustav sediment mobilization evidence. (A) mean along 
(solid) and across-shelf (dashed) current at 1.22 mab, (B) subtidal along (solid) 
and across-shelf (dashed) current at 1.22 mab, (C) significant wave height, (D) 
dominant wave direction, (E) near-bottom wave orbital velocity, (F) shear 
velocity due to currents (asterisk) and shear velocity due to waves and currents 
(star), and (G) acoustic backscatter signal at 1.2 mab. Positive along-shelf is 
defined as being directed to the southwest and positive across-shelf is directed 
offshore.  Dates given are in coordinated universal time (UTC) beginning at 0000 
UTC.  Paired vertical lines outline duration of event. 
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s-1 (Fig. 12E, G).  As Gustav moved further northward on September 11, wave heights and wave 

orbital velocities subsided due decreasing wind intensity and a shift in wind direction from 

onshore to offshore. 

Combined wave-current (u*cw) shear velocities ranged from more than 2.0 to 6.4 cm s-1 

for approximately 36 h coinciding with the peak in ABS signal (Fig. 12F).  When compared to 

the calculated Rouse numbers for the fine-grained sands that dominate this locale, incipient 

suspension would have been ongoing over this period.  In addition, a very brief period (<8 h) of 

full suspension occurred between 2000 UTC on September 9 and 0400 UTC September 10.  

Thus, a significant portion of the fine-grained fraction of the bed surface was at least  suspended 

periodically and sediment mobilization during the event was most likely significant.   

During peak conditions, it is likely the fine sands on the seabed were being driven in the 

easterly direction as bedload under the influence of wave driven oscillatory flows (Fig. 12D).  As 

indicated by shear velocity values for the same period, much of this sediment (< 0.2041 mm) was 

also being temporarily entrained into the water column as incipient suspended load.  Once off the 

bottom, the motion of this material was governed primarily by the dominant current in the near-

bed layer, which during peak conditions was a wind-driven along-shelf subtidal flow directed 

from northeast to southwest at magnitudes ranging from 0 to 9.8 cm s-1. The across-shelf subtidal 

flow at this time remained negligible (Fig. 12B).  Although weak, these currents are capable of 

transporting sediment suspended in the near-bottom short distances to the southwest over the 36 

h period of maximum mobilization.  Acting in concert, waves and subtidal currents then 

potentially set up a net transport of fine-grained sediment to the southwest in the along-shelf 

direction and onshore in the across-shelf direction. 
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Hurricane Isabel: September 15 - 20, 2003  

 Hurricane Isabel developed off the west coast of central Africa and was named on 

September 6, 2003.  It continued a northwestward track for the next several days intensifying to a 

strong Category 5 hurricane on the Saffir-Simpson Scale early on September 12 and began 

impacting the coastal waters of Onslow Bay on September 15.  By September 17 winds reached 

tropical storm strength (> 34 knots) and remained above this threshold for more than 30 hours.  

From 1600 UTM September 17 to 0500 UTM September 18 (14 h), winds were strong out of the 

N-NE.  After passage of the central hurricane eye approximately 225 km east of Onslow Bay on 

September 18, winds quickly backed to the W-SW for more than 15 h.  The highest winds 

recorded (>60 knots) occurred during this period.   

 Isabel was the largest magnitude event recorded during the period of study and began to 

impact the shelf waters offshore of Wrightsville Beach early on September 15 when long period 

swells (Tp >18 s) began to approach from the southeast.  Significant wave heights through the 

event remained elevated above the average of 0.9 m and reached a maximum of 2.5 m (Fig. 

13C).  Throughout the duration of the event near-bottom wave orbital velocities associated with 

the long period swells mobilized fine-grained sands at the OB3M study site.  Later, increasingly 

high-velocity winds generated a localized short-period wave field atop the long period swell, 

which also contributed to mobilization of surficial bottom sediments.   

 Between September 15 and September 16, the near-bottom mean current attained 

velocities between 0.2 and 10 cm s-1 at 1.2 mab.  These currents were highly variable in direction 

prior to September 17 due to the dominance of the M2 semidiurnal tidal component.  During 

storm maximum, however, mean currents reached 26.1 cm s-1, the highest on record during the 

entire study period.  Subtidal currents ranged from 1.9 to 19.7 cm s-1 during the time, but  
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Fig. 13.  Hurricane Isabel sediment mobility evidence. (A) mean along (solid) 
and across-shelf (dashed) current at 1.22 mab, (B) subtidal along (solid) and 
across-shelf (dashed) current at 1.22 mab, (C) significant wave height, (D) 
dominant wave direction, (E) near-bottom wave orbital velocity, (F) shear 
velocity due to currents (asterisk) and shear velocity due to waves and currents 
(star) and (G) acoustic backscatter signal at 1.2 mab. Positive along-shelf is 
defined as being directed to the southwest and positive across-shelf is directed 
offshore.  Dates given are in coordinated universal time (UTC) beginning at 
0000 UTC.  Paired vertical lines outline duration of event. 
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increased in intensity due to forcing by the local wind field as Isabel approached and then passed 

east of Onslow Bay waters. Wave orbital velocities ranged from 20 cm s-1 to greater than 40 cm 

s-1 during storm approach, but during storm maximum ranged between 40 and 63 cm s-1 (Fig. 

13E).  Calculated shear velocity values indicate that under these conditions, fine sands would 

become fully entrained as suspended load and coarse sand material would begin be agitated 

under the stresses imparted by wave action. This is further evidenced in sidescan sonar data 

collected post-storm that demonstrates a “freshening” of symmetrical wavelength megaripples 

within coarse sand bodies as well as minor changes in the orientation of these bedforms.  Very 

coarse sand to sandy gravel-sized bedforms at similar depths (<30 m) are believed to be only 

reactivated during extreme conditions (Riggs et al., 1996; Thieler et al., 2001) such as those 

associated with peak conditions during Isabel.  This study shows that it is only during these very 

extreme high-energy events are critical shear velocities reached to allow the mobilization of the 

coarse grain sediments. 

 Combined wave-current shear velocity ranged from 1.7 to 8.6 cm s-1 for 72 successive 

hours with maximum shear velocities coincident with the period of maximum wave activity (Fig. 

13F).  Again employing the Rouse Parameter, these conditions easily exceed critical values 

required to mobilize fine sands present on the inner-shelf seabed.  Further, shear velocities in 

excess of 6.2 cm s-1 would produce full suspension of fine grain sands (diameter ≤0.2041mm).  

These conditions were met for 36 consecutive hours between 0000 UTC on September 17 

through 1200 UTC on September 18.  An elevated ABS obtained during the period and fine-

grained sand collected in a sediment tube mounted 0.23 m above the bottom further indicate the 

suspension of bottom sediments (Fig. 13G).   
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Prior to full suspension, fine sands were found to be mobile as bedload and as incipiently 

suspended load.  During this time, the direction of transport is believed to be dominated 

primarily by wave orbital velocity and the direction of wave approach.  Dominant wave direction 

was from the east-southeast, which would create a net transport to north in the along-shelf and 

onshore in across-shelf direction period (Fig. 13F).  The fraction of fine sand material 

temporarily suspended above the bed would again be influenced by the prevailing current 

direction, which in this case was from northeast to southwest in the along-shelf.   

Once in suspension these sediments are likely to have been transported by means of the 

above average subtidal currents, produced via high velocity winds at the surface, which 

increased over this time from less than 5.0 cm s-1 to greater than 19.5 cm s-1.  These flows 

initially directed in the positive along-shelf direction and negligibly in the cross-shelf direction 

favored transport of suspended sediment predominately southwestward.  After the wind switch to 

the west-southwest direction, the subtidal currents responded and became directed in both the 

negative along-shelf and across-shelf directions, which supports transport of sediment remaining 

in the water column to the northeast and onshore directions (Fig. 13B).  

Sidescan Sonar Change Detection Analysis 

 Six areas on the lower sand flat adjacent to the marine hardbottom reef at the OB3M site 

were chosen to perform a change detection analysis across the time series of mosaics (Fig. 14).  

The objective of the change detection analysis was to determine trends in mobility of both the 

fine and coarse grain sand bodies and to attempt to link this mobility (or lack there of) to near-

bottom layer hydrodynamic conditions produced in response to significant seasonal 

meteorological events.  Areas were selected based on distinct high/low backscatter signatures 

that created highly visible, well-defined contact zones between adjacent lithofacies of surficial 
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Fig. 14.  Location of 6 subareas where change detection analysis was performed using 
biannual sidescan (100 kHz) surveys.  Subareas were chosen based on proximity to both the 
marine hardbottom area and to CORMP ADCP instrumentation (denoted by star). Mosaic 
image was obtained March 14, 2002 
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sediment cover.  Two subareas, consisting primarily of gravelly coarse sands (CS#), and four 

subareas of the presumably more mobile fine sand fraction (FS#) were chosen (Fig. 14).   

Due to the inherent error that accompanies DGPS measurements during sonar acquisition 

and the subjectivity in the digitizing process of the fine/coarse sand contacts, a 10 m error 

tolerance buffer was introduced around the perimeter of each selected subarea (Fig. 15).  

Displacements beyond this buffer were considered significant.  The 10 m buffer is likely to be a 

conservative estimate of the potential error introduced as the marine hardbottom as well as two 

sunken barges (Fig. 3) provided a natural, nonmoveable set of benchmarks on which the 

individual sonar lines from repeat surveys were aligned.  Thus, subareas selected closer to these 

regions were better resolved in space and were more likely to be accurately geo-referenced, 

thereby limiting the error introduced via DGPS measurements.  Subareas were typically chosen 

toward the center of the swath, but offset from the nadir region, to avoid pixel distortion 

introduced with increased grazing angle of the sonar beam toward the edges of the line. An 

example of the overlays used to perform change detection analysis is given in Fig. 16 and 

specific steps for performing change detection analysis using this methodology can be found in 

Appendix C.  Expanded results for each subarea are also given in Appendix D.   

Coarse Sand Body One (CSB-1) 

The CSB-1 area is located within a sheltered portion of the lower sand flat where the 1.5 

meter high crescent-shaped hardbottom reef bounds much of the sand body perimeter at 

distances ranging from 3 to 80 m.  The northern boundary of the body is most sheltered (3 to14 

m from reef ledge), yet exhibited a moderate degree of morphological change varying as much as 

+/- 7 m in variable direction between the four surveys (Table 17A).  The western contact was 

highly stable survey to survey wavering only +/-4 m in an inconsistent direction along its entire  
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Fig. 15.  Ten meter error buffer surrounding subarea sand bodies located on the lower 
sand flat where change detection analysis was performed.  
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Fig. 16.  Sand contact displacement results from CSB-2 spanning the period between March 
2002 and October 2003.    
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Fig. 17.  CSB-1 and FSB-1 sand body contacts.    
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 50

flank, while the eastern edge migrated westward between the fall 2002 and spring 2003 surveys, 

before shifting eastward again at the fall 2003 survey date to a position very similar to that of the 

fall 2002 survey.   The displacement of these contacts at no point exceeded the 10 meter error 

tolerance buffer and there was no identifiable net displacement of the body during the course of 

the four surveys conducted (Table 5).  Areal extent, however, of the sand body itself was deemed 

significant.  It reached a minimum of 3870 m2 in spring of 2003 and experienced a maximum of 

4775 m2 during the initial survey of spring 2002, for a change of nearly 1000 m2 over the 

fourteen-month period.  Also of note are the emergence, deletion, and migration of randomly 

placed fingers of coarse sediment along the boundary edge from survey to survey.  These fingers 

seem to be a result of fine sands bordering the coarse sand body becoming mobilized and in the 

process covering and uncovering the less mobile coarse sand fraction.  Given the proximity of 

CSB-1 to the location of the fixed hardbottom ledge, these data are regarded to be highly 

reliable, such that the 10 m buffer is considered overly conservative. 

Fine Sand Body One (FSB-1) 

The FSB-1 area is centrally located on the lower sand flat and is positioned 

approximately 180 m due west of the hardbottom reef and 153 m west of the moored 

instrumentation package.  A very small area, compared to other sand bodies observed, this fine 

sand body demonstrated the greatest amount of net displacement, although it did not fall outside 

of the established 10 meter error tolerance buffer.  From spring 2002 to fall 2002 the well-

defined contact boundary swelled in nearly all compass directions expanding the areal extent of 

the sand body by more than 30% (Fig. 17B).  Between fall 2002 and spring 2003 areal extent 

decreased slightly, but a high degree of displacement (146 m2) was observed in the northwest 

direction with little change in overall morphology of the sand body.  The contact perimeter  
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Table 5.  Displacement (m2) and net direction of movement of selected subareas located on lower sand flat adjacent to marine 
hardbottom reef.  Percent change (grey shaded area) is the calculated displacement during the period divided by final area measured at 
the end of the period and normalizes the degree of change for comparative purposes. ND = no observed net directional component.  
Asterisk (*) denotes loss of NE corner of data due to nadir region during this period.  # denotes sand body extends over nadir region 
for all surveys.  

 
 

Spring ’02 - Fall ‘02 
3/14/02 - 11/21/02 

% 
Change 

Fall ‘02 - Spring ‘03 
11/21/02 - 5/30/03 

% 
Change 

Spring ’03 - Fall ‘03 
5/30/03 - 10/14/03 

% 
Change 

CSB-1 315 m2 ND  7% 438 m2 W-NW 11% 490 m 2 E 11% 
CSB-2 233 m2 ND  16% 257 m2 ND  15% 152 m2 N/NE  9% 
FSB-1 62 m2 ALL ≠ E-NE 15% 146 m2 N-NW  38% 44 m2 SE 13% 
FSB-2 312 m2 ND* 9% 545 m 2 N  13% 588 m2 ND  15% 
FSB-3 478 m2 S-SW  7% 384 m2 ND  11% 540 m2 ND  22% 
FSB-4# 1378 m2 ND# 9% 750 m2 ND#  5% 832 m2 ND#  7% 

Average% 
Change  10.5 %  15.5%  12.8% 

 

 



 

between spring 2003 and fall 2003 demonstrated variable mobility along the eastern boundary 

with four small fingers emerging in the southeast, however, overall this same flank demonstrated 

no appreciable net movement (Fig. 17B).  During this same period, the western and northern 

boundaries were shifted to the southeast approximately 1.5 to 2 m, but the remainder of the body 

remained stable.  Overall, there was a clearly identifiable shift in the entire body to the northwest 

from the initial 2002 survey to the final fall 2003 survey.  This migration, however, was deemed 

insignificant as it did not surpass the 10 meter buffer (Fig. 17B).  

Coarse Sand Body Two (CSB-2) 

The CSB-2 area is located approximately 75 m south-southwest of the low-relief 

hardbottom reef and approximately 100 m due south of the moored instrumentation.  It is 

encompassed by a minimum of 30 m of surficial fine grain sand on all sides, which makes up the 

contact boundary.  The extent of this body lies completely within line 6 of the sidescan surveys.  

Between the spring 2002 and fall 2002 surveys, this irregularly shaped body showed little 

organized displacement (Table 5, Fig. 18).  However, the southeast contact shifted 

northwestward approximately 6-9 m while the remainder of the contact remained stable except 

for a small segment on the east flank, which also migrated west-southwest approximately 4 m.  

Further, the same southeast section as well as southwest contact flank expanded southward 

between the fall 2002 and spring 2002 surveys, while again the remainder of the coarse body 

experienced little change.  The expansion ranged from approximately 3 m to more than 6 m.  

Overall, between the initial spring 2002 survey and final fall 2003 survey, there was minimal 

morphological change in both the shape and position of CSB-2 (Fig.18).  Of significance, 

however, is the transient motion of the contact position itself, which seems to waver 

indiscriminately in conjunction with the sporadic mobilization of the fine-grained sediment  
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Fig. 18.  CSB-2 and FSB-2 sand body contacts.    
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bordering the body.  This is evidenced by the changes in areal extent from survey to survey, 

which ranged from a minimum of 1420 m2 during the fall 2002 survey to a maximum of 1731 m2 

observed during the fall 2003 survey.   

Fine Sand Body Two (FSB-2) 

FSB-2 is located south of the FSB-1 and CSB-2 areas and approximately 176 m south of 

the nearest reef ledge.  This area, contained completely on line 6 of the sidescan survey, showed 

no consistent change in net displacement over the course of the four surveys, however other 

notable morphologic changes were observed (Fig. 18).  Initially, the contact observed in the 

spring 2002 survey between FSB-2 and the surrounding coarse-grained sediment was very well 

defined.  From the initial survey to fall 2002, the contact remained stable along the eastern flank, 

yet an expansion of the contact perimeter between 0 to 5.5 m was observed across the remainder 

of the boundary.  Total area increased slightly between these two periods, even though a small 

portion of the fall 2002 sand body was not digitized due to crossing of the nadir.   In spring 2003, 

the areal extent of FSB-2 again swelled, increasing in coverage by over 17% from spring 2002 

(Fig. 18).  This expansion mainly occurred along the northern perimeter where this contact 

expanded northward from 0 to 15 m.  The eastern flank remained stable, exhibiting almost no 

variability between surveys, while the southwestern flank also moved northward although in a 

rather inconsistent, highly variable pattern.  Further, the spring 2003 survey exhibited the 

emergence of a narrow finger of fine sand protruding southeastward from the main southern 

contact boundary (Fig. 18).  This same finger expanded southward in the fall 2003 survey and 

extended more than two thirds of the western contact perimeter.  Additionally, the contact 

between spring 2003 and fall 2003 again was modified, but instead of expanding, this time the 

vast majority of the perimeter contracted, causing the areal extent of the body to diminish by 
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about 7%.  Overall, there was no significant displacement during the nineteen-month period 

(Table 5) 

Fine Sand Body Three (FSB-3) 

The FSB-3 subarea positioned 540 m from the nearest reef edge is also the most southern 

sand body from the CORMP instrumentation, which is 741 m to the north-northwest.  FSB-3 is 

560 m southeast of CSB-2 and is contained entirely within line 8 of the sidescan surveys.  

Although no significant net displacement was observed between the spring 2002 and fall 2002 

surveys (Table 5), FSB-3 expanded in area by more than 35% from its initial size of 2603 m2 

(Fig. 19A).  This expansion, ranging from 0.5 to 7.75 m, occurred around the entire contact 

boundary except for a localized area in the northeast.  Little morphological change occurred 

between the fall 2002 and spring 2003 surveys, and total area of the body remained constant.  

Similar to FSB-2, there was an emergence of a set of fingers in the southeast quadrant of the 

body, which were not apparent in the fall 2002 survey (Fig. 19A).  Interestingly, these fingers 

grew in extent over the period leading up to the fall 2003 survey and evolved into a set of 

independent thinly veneered fine sand bodies covering the coarse-grained sediments contacting 

the boundary of FSB-3.  The area of FSB-3 diminished 30% during the 5-month period between 

spring and fall 2003 surveys to 2490 m2.  From spring 2003 to fall 2003, there was a slight net 

displacement to the west of this body totaling 538 m2, however, this shift did not exceed the error 

tolerance buffer (Table 5).  

Fine Sand Body Four (FSB-4) 

FSB-4 is the western most situated sand body in the study area, located 740 m west-

southwest of FSB-2 and 930 m west-southwest of the moored instrument cage.  This area is  
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Fig. 19  FSB-3 and FSB-4 change detection analysis 
results.    
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located on line 8 of the sidescan survey and the eastern third of the FSB-4 crosses over the nadir 

region of the line swath, in effect limiting analysis results (Fig. 19B).  The eastern contact 

displayed consistent expansion across its boundary ranging from 4 to 9.5 m between spring 2002 

and fall 2002.  From fall 2002 to spring, 2003 FSB2-3 exhibited little morphological change; 

however, the western boundary, which swelled between the previous two surveys, retreated to a 

similar position observed in spring 2002.  Between spring 2003 and the final survey conducted in 

fall 2003, revealed further morphological change in the high and low backscatter contacts, 

specifically along the western boundary which continued to retreat eastward at variable rates 

ranging from about 1.0 to 7.5 m over the five-month time frame.  The remainder of the contact 

showed little displacement and appeared rather stable.  Overall, there were no significant 

changes that exceeded the established 10 m error tolerance buffers during the nineteen-month 

period between initial and final surveys.  Further, due to the nadir region cutting directly across 

FSB-4, changes in area and net displacement reported in Table 5 are likely to be less reliable 

than previously discussed subareas.  

DISCUSSION 

Three physical processes active in the near-bed layer have been identified as the major 

forcing mechanisms responsible for mobilizing, suspending, and transporting sediment across the 

inner-shelf seabed in response to the broad spectrum of environmental surface conditions 

experienced in the Southern Atlantic Bight.  Surface gravity waves and their associated near-bed 

orbital velocities, near-bottom mean currents dominated by low-frequency subtidal flows 

generated from surface winds, and slowly reversing tidal currents dominated by the M2 

semidiurnal component all have measurable roles.  These mechanisms are found to work 

synergistically with each other leading to the mobilization and minor transport of surficial fine 
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sand sized sediment in both the along- and across-shelf directions.  It is clear that sediment 

transport occurring at this inner-shelf location is primarily driven by a complex combination of 

wave-current interactions of the aforementioned variables similar to those first noted by Grant 

and Madsen (1979).   

 Four classes of meteorological events were identified as initiating significant periods of 

sediment mobility throughout the nineteen-month duration of study.  Tropical storms, 

extratropical low pressure areas including nor’easters, air mass boundaries and associated fronts, 

as well as fair-weather southerly wind events all played contributing roles in elevating local sea 

state and local winds for several hours to days, ultimately resulting in high-energy sea bottom 

conditions required for moving unconsolidated seabed material.  Four tropical events occurred 

during the nineteen-month period of study and were found to be the most influential class of 

events on record.  Back to back occurrence of two moderate to strong tropical systems over a 

sixteen-day period in September 2003 is believed to be responsible for effectively shifting large 

quantities of sediment and drastically changing the sedimentation pattern between two similar 

seasonal periods within the study. 

Data presented in this paper illustrate that near-bottom conditions at this discrete inner-

shelf site are frequently energetic enough to agitate sediment as bedload and very often 

incipiently suspend fine-grained sand in response to a wide range of surface weather events.  

Model output from the Styles and Glenn (2002) boundary layer model indicate that conditions 

fall below critical values for no movement approximately 33.9% of the time.  The remaining 

periods were dominated by bedload movement approximately 16.6% of the time and upon higher 

energy conditions as incipiently suspended load more than 48.9% of the time.  Conditions 

required for full suspension of the fine sand material were very rare and found to occur during 
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less than 1% of the study period.  Of this 1%, 72% occurred during the passage of Hurricane 

Isabel.  Coarse grain sediments are believed to be only weakly mobile under even the most 

extreme conditions and were not found to be moved significantly during the course of study.   

Interestingly, however, upon first visual inspection, high-resolution sidescan sonar 

imagery of the seafloor reveal that over the study period conditions did not favor mass exchanges 

of sediment in the along-shelf and across-shelf directions such that the gross morphology of the 

seabed is markedly modified.  These findings are similar to Thieler et al. (2001) who saw no 

significant changes in the distribution of fine and coarse sands in repeat high-resolution sidescan 

sonar surveys (Klein 100 kHz) of the lower shoreface offshore of Wrightsville Beach over a 

three-year period consisting of normal climatological conditions.  Thieler et al. (2001) suggested 

that “typical” storms and other high-energy events do not result in large-scale changes to the 

limited veneer of fine sediments available for transport.  Rather, the unconsolidated fraction of 

the seabed appears to be relatively stable even under the stress of physical forcing mechanisms 

produced in response to several high-energy events over the course of a nineteen-month period 

with little change in shape and location.  Findings here, as defined by the established error 

tolerances, also shows there was only a limited degree of significant net directional transport 

observed amongst the six sites examined.  However, in the five to seven month periods between 

repeat surveys, it was common to see the areal extent of the sand bodies substantially expand and 

contract, or to have fingers of fine sand material simultaneously emerge, migrate short distances, 

only later to be winnowed away elsewhere on the inner-shelf.   

A conceptual model composed of a two-tiered data matrix was developed to better 

constrain the long-term effects physical processes acting in the near-bottom have on the 

distribution of surficial sediments.  In this model, the twenty-three sediment mobility events 
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identified and their defining characteristics were clustered according to occurrence with respect 

to the biannual acquisition dates of sidescan sonar (Table 6).  Further examination of the six sand 

body subareas focused on collective changes in sedimentation patterns for the periods between 

sidescan cruises rather than individual changes in displacement and net direction of movement.  

Several interesting results were produced by this analysis comparison. 

During the period between March 14 to November 21, 2002 (hereafter 2002 spring-fall), 

which are the respective dates high-resolution sonar imagery were acquired, a 7 to 18% decrease 

in the areas of the two coarse sand bodies was observed, while each of the four fine sand bodies 

probed exhibited a substantial increase in area.  Conversely, the reverse was true for a similar 

period of time just one year later between May 30 and October 14, 2003 (2003 spring-fall).  

During the 2003 spring-fall period, the coarse sand bodies gained area, while each of the fine 

sand sheets examined were significantly reduced in size. The intermediate period between 

November 21 to May 30 showed little consistent pattern in areal change and will not be 

discussed further in great detail (Table 6A).   

Focusing first on the spring-fall 2002 period, eight sediment mobility events were 

recorded, including two events associated with weak to moderate tropical events.  Maximum 

wave-current shear velocities exceeded full suspension limits for a maximum of one eight hour 

period during Tropical Storm Gustav, otherwise the primary mode of sediment transport during 

the high-energy events of this period was incipient suspended load and bedload. These modes of 

transport are believed to be driven principally by waves and their associated near-bed wave 

orbital velocities.  Although several strong wind events did occur, subtidal currents in the near-

bed layer remained weak and played a minor part in redistributing sediment.  Maximum subtidal  

 



 

 

 

 

 

 

 

 

Table 6.  Conceptual model comparing area analysis of six subareas examined during biannual sidescan sonar results to 
frequency, distribution, and intensity of high-energy sediment mobility events.  High-energy events are clustered according to 
the corresponding time between repeat surveys.  Cells highlighted in blue in Table 6A represent a positive increase in sand 
body area while orange reflects a net decrease in sand body area. In Table 6B, u*cw values highlighted in bold indicate the 
critical threshold for full suspension of fine-grained material was exceeded.  Duration = time (hr) ABS signal is above criteria 
level and. Subtidal magnitude, ub, and u*cw are each given in cm sec-1. 
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Table 6A. % Change in Sand Body Area between Repeat Sidescan Surveys 

 
Spring 2002 - Fall 2002 

3/14/02 - 11/21/02 
Fall 2002 - Spring 2003 

11/21/02 - 5/30/03 
Spring - Fall 2003 
5/30/03 - 10/14/03 

CSB-1 -7% -14% +15% 
CSB-2 -18% +17%   +5% 
FSB-1 +31% -9%   -14% 
FSB-2 +3%* +18% -7% 
FSB-3 +36% +1% -30% 
FSB-4 +14.8% -6% -8% 
Avg. 18.3 % 10.8% 13.2% 

 

 

 

Table 6B. Sediment Mobility Event Characteristics 
 #1 #2 Gu #4 Ky #6 #7 #8 #1 #2 #3 #4 #5 #6 #7 #8 #9 #1 #2 He Is #5 #6 

Type ETlo ETlo T ETf T ETlo ETf ETlo ETf ETlo ETf ETlo ETlo ETf ETf ETf ETlo ETsw ETsw T T ETf ETf 
Duration 29 42 24 6 19 22 12 13 10 11 11 53 16 8 22 7 11 18 12 23 79 23 14 
Subtidal 

Along SW SW SW SW SW  
-NE SW SW NE SW SW- 

NE NE NE SW NE SW-
NE SW SW NE NE SW SW - 

NE NE SW 

Subtidal 
Across off off off off off off off on on on on on off on off-

on on off on on on off - 
on on off 

Subtidal 
Max.  15.1 12.0 9.8 7.4 6.0 8.3 13.3 7.2 7.0 14.8 8.9 12.2 5.2 7.9 9.0 7.1 7.7 10.9 9.2 11.0 19.7 9.9 11.6

Hs 
Approach 

E -
SE 

E - 
SE 

E - 
SE 

E -
SE S 

E - 
SE-S 

NE - 
SE 

NE - 
SE 

SE -
NE S SE-S SE-S S-E E-SE SE S-

SE-S E-SE SE SE-S S SE-E
SE-
E-N 
NW 

SE-E S 

ub  
Max. 24.7 31.6 37.5 30.8 18.9 23.7 22.5 14.3 32.9 24.2 15.0 42.9 20.5 26.3 21.7 18.1 27.5 23.4 11.0 43.2 63.9 23.1 26.1

u*cw  
Max. 5.1 6.0 6.4 5.8 4.5 5.0 4.9 4.1 6.0 5.0 4.1 7.0 4.6 5.3 4.8 4.4 5.5 5.1 3.9 7.1 8.6 5.0 5.3 

 

 



 

current velocities ranged from 6 to 15 cm sec-1 for the eight recorded events and were generally 

directed to the southwest in the along-shelf direction.   

The observed sedimentation pattern reflects both the near-bottom hydrodynamic 

conditions during high-energy periods and the surficial geology of a sediment starved seabed.  

The “patchy” cover of fine sand present on the lower shoreface and inner-shelf of Onslow Bay is 

limited and composed of a finite volume of material of thicknesses on the order of 50 cm or less 

(Thieler, et al. 1995).  The fine sand sheets are typically linear to slightly irregular with little 

relief, however, it is expected that the maximum thicknesses are central to the body and thin to a 

fine veneer at their edges as they transition into the less mobile gravelly coarse sand bodies 

present as a lag pavement.  During extensive periods of mobilization, fine sands central to the 

bodies are effectively spread outward by the oscillatory motions produced via near-bottom wave 

orbitals.  In the process of being mobilized as bedload and incipient suspended load, the fine 

sands spill overtop adjacent immobile coarse-based pavement areas and are deposited as normal 

bottom conditions ensue.  Diver collected boxcores obtained throughout this research exhibit 

instances of fine sands (<10 cm typically) overlying coarse-grained materials (Fig. 20).  Thieler 

et al. (2001) also inferred a similar process around the edges of ripple scour depressions inshore 

of this location.   The authors also noted that the large megaripple crests associated with coarse 

material were able to be identified below the overlying fine sand laterally for several meters.  

Overall, the net effect of the hydrodynamic regime associated with high-energy sediment 

mobility events during the 2002 spring-fall period was to substantially increase the area of the 

fine sand bodies and simultaneously diminish the total area of adjacent surfaces consisting of 

poorly sorted coarse-grained material.    
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Fig. 20.  Sediment relief peel produced from diver collected boxcore obtained 
approximately 30 m south of OB3M instrumentation cage.  This peel demonstrates 
the mobility of fine sands overtopping and infilling less mobile adjacent coarse 
sand body areas. Core length is approximately 26 cm.   
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During the 2003 spring-fall period, the sedimentation pattern is much different than that 

observed during the 2002 spring-fall period.  The two coarse-grained sand bodies increased in 

area by an average of 10% whereas the four fine-grained sand bodies exhibited a 15% average 

decrease in area.  During this period, a total of six events were identified, including the two 

strongest events recorded, Tropical Storm Henri and Hurricane Isabel, which impacted the region 

over the sixteen day period beginning September 3 and ending on September 19.  As Table 6B 

shows the majority of storm parameters between the two periods are comparable in magnitude 

and direction.  

The only significant difference between the two periods is the mode of sediment transport 

achieved in response to the available energy in the near-bottom.  The 2003 period experienced an 

extended episode of sediment mobility yielding full suspension conditions during the height of 

Hurricane Isabel.  For forty-eight consecutive hours beginning at 0000 UTC on September 16, 

combined wave and current shear velocities exceeded critical thresholds required for full 

suspension of fine sands (Fig. 13F).  Additionally, during the preceding 20 hours prior to this 

period, u*cw values averaged 5.9 cm sec-1, which is just below full suspension criteria and well 

above six of the eight maximum values observed for all sediment mobility events occurring  

during the 2002 spring-fall period (Table 6B).   

A sediment tube attached 23 cm above the seabed to the instrumentation cage at the 

OB3M site during the research provides further evidence of the tremendous impact Isabel had on 

the seabed and suspension of bottom sediments.  In the six-month period from March 2002 to 

June 2003, 205.4 g of sediment were collected for a sedimentation rate of approximately 58 g-

mos-1.  During the three-month period from July to late September 2003, 512.4 g of sediment 
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were obtained for a sedimentation rate of over 204 g-mos-1 (Fig. 21).  Mean grain size calculated 

for this material was 0.2370 mm for  

the pre-Isabel period and 0.2085 mm for the time bracketing Hurricane Isabel.  In both cases, the 

material is classified texturally as moderately sorted fine sand.  Given this information, this is an 

extreme event unlike that recorded elsewhere throughout the duration of this research.   

Widespread suspension of the fine-grained fraction during this solitary extreme event had 

a substantial effect on the unconsolidated surface cover.  Although the resulting suspension did 

not support net transport of entire fine sand bodies in a given compass direction as was expected, 

the processes at work did act to modify the contact boundaries where fine and coarse-grained 

sand bodies meet.  This is evident in the sedimentation pattern that completely reversed itself 

from the 2002 spring-fall season Table 6A).  As stated earlier, fine sands form only a thin cover 

overtop the coarse grain pavement lag.  This is especially true around the perimeters of these 

bodies where the fines intermix and transition into areas composed primarily of coarse-grained 

material. Under full-suspension conditions, fine sands were effectively winnowed away from 

these areas where they were only sparse in cover at the onset.  At the conclusion of the event, the 

result was that much of the material that had composed the thin veneers near the contact edges 

was swept away later to be redeposited elsewhere on the shelf.  As Table 6B illustrates, the two 

coarse-grained subareas examined here gained area due to this sweeping action of the fines, 

while fine sand bodies lost area as their edges were winnowed away during the period of full-

suspension. These findings concur with the qualitative study of Backstrom (2002), which 

examined the storm-driven sedimentary changes in the lower shoreface and inner-shelf region 

offshore of Kure Beach, North Carolina (approximately 14 km southwest of this study area).  

Visual examination of two sidescan sonar mosaics did not reveal significant sedimentary changes  
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Fig. 21.  Bar graph showing distribution of suspended sediment amounts obtained in a 
sediment cup positioned 23 cm above the seabed and mounted vertically to the OB3M 
instrumentation cage.  Note the peak during the period including the passage of two 
strong tropical events (Tropical Storm Henri and Hurricane Isabel) during September 
2003.   March 2003 was the initial deployment date of the sediment cup.  
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before and after the passage of hurricanes Dennis and Floyd (1999).  However, on a smaller scale 

there were regions of noticeable differences in acoustic backscatter suggesting minor changes in 

grain size texture and spatial distribution.  Over the region of study, a reduction of fine-grained 

unconsolidated sediments was compensated for by new exposures of low-relief marine 

hardbottom reefs that were not visible prior to storm activity (Backstrom, 2002).  It is 

conceivable that without an extreme high energy similar to Isabel, the distribution of sediment 

cover across the study region would have likely resembled that of the preceding 2002 spring-fall 

period.  

One potential caveat to this scenario is the discrepancy between the duration of the two 

repeat sonar surveys being compared.  The 2002 spring-fall period encompasses a larger portion 

of time than the 2003 spring-fall period and accounts for a period of time that would be 

climatologically more active (early spring and later fall).  Further, wave and current data, and 

thus our sediment mobility event identifying criteria extend back to only April 25, 2002, while 

the first sidescan sonar period begins on March 14, 2002.  Review of wind, wave and 

atmospheric pressure data from the FPT C-Man station between March 14 and April 25 

suggested the occurrence of two more weak events during this period that had the potential to 

mobilize sediment.  It was concluded, however, that these events were likely to be of little 

consequence based on the specific meteorological data.  

CONCLUSIONS 

High-energy events play a major role in the mobilization of sediment on the inner-

continental shelf of Onslow Bay and are produced in response to a variety of meteorological and 

oceanographic processes.  These processes are manifested within the near-bottom layer as a 

combination of three dominant physical forcing mechanisms, all with a contributing role in 
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initiating and sustaining sediment transport within the inner-shelf region.  Semidiurnal tidal 

currents, waves and corresponding near-bottom wave orbitals, as well as mean currents 

dominated by wind-generated subtidal flows work in conjunction with one another to induce 

stress on the surficial seabed and exceed critical thresholds for mobilizing sediment.  The fine-

grained sediment fraction of the seabed is frequently agitated even under average fair-weather 

conditions.   

For all events, the dominant mechanism for mobilizing and vertically mixing sediments 

into suspension is increased bed shear stress due to wave orbital action.  Subtidal currents, 

although elevated well above ambient levels during intense wind events to velocities exceeding 

15 cm sec-1 remained weak in comparison to wave inputs and play only secondary roles.  

According to critical shear velocity values calculated for the fine sand portion of the seabed, 

material with a mean grain size of less than 0.2041 mm was mobilized more than 66% of the 

time over the nineteen month period in response to the combined effects of near-bottom wave 

and current interactions.  During higher-energy events, fine sand is often mobilized through a 

combination of bedload and incipiently suspended load, and less frequently via fully suspended 

load, which accounted for less than one percent of the total time sediment was in motion. 

Twenty three sediment mobility events were identified consisting of a broad range of 

intensities and durations.  A generalized classification system based on common meteorological 

events observed across the region demonstrates that over the nineteen- month period of study 

extratropical low pressure areas most frequently initiated a seabed response.  In a normal 

climatological year, these would include several nor’easter type storms, which in the past have 

been observed to be quite influential in transporting large quantities of sediment across inner-

shelf regions.  However, during the time frame of this research, there were no major nor’easters 
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recorded off the southeast North Carolina coast.   In general, there were eight occurrences of 

events where closed isobar areas of low pressure and associated frontal boundaries directly 

influenced the region, seven involving the passage of frontal boundaries, two fair-weather 

southerly winds events and four tropical systems.   

Repeat high-resolution sidescan sonar surveys obtained over the same time, however; 

provide evidence that interannual changes to the sedimentation pattern of this sediment starved 

inner-shelf region were only significantly influenced by the occurrence of a singular tropical 

born storm system that impacted the shelf waters of Onslow Bay in September 2003.   Hurricane 

Isabel elevated near-bottom wave orbital velocities to more than six times their fair-weather 

average and caused full-suspension of sediment for more than forty eight consecutive hours.  

This accounted for more than 72% of the full suspension conditions observed during the entire 

March 2002 to October 2003 period and was observed nowhere else in the record of study.  

Thus, the occurrence of several lesser storms of moderate energy, that are climatologically 

higher in frequency, but less intense are less likely to change the distribution and gross 

morphology of limited amount of surficial sediment cover that exists at this inner-shelf location.  

This is in relation to the occurrence of a sole extreme event, such as Hurricane Isabel, that is 

several times more intense and impacts the region for only a fraction of the time as all other 

events combined.   Although the overall gross morphology and sediment distribution remained 

relatively unchanged even after the passage of Isabel, changes in shape, size, and orientation of 

six observed sand bodies did occur and were most changed after the passage of this one extreme 

event.   
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APPENDICES 
 
Appendix A: 2002 sediment mobility events recorded from June through December 2002. # - limited data due to equipment failure.  
Etlo = extratropical low pressure area; T = tropical born system; ETf = extratropical frontal boundary; BH = southerly wind event. 
Events denoted by an asterisk are highlighted in the Results section 
 

2002 Events Type Winds 
(knots) 

Hs  
(m) 

Tp
(sec) 

ub
(cm s-1) 

ABS 
(dB) 

Mean  
current 
(cm s-1) 

Subtidal 
current 
(cm s-1) 

u*c
(cm s-1) 

u*cw 
(cm s-1)

1. 5/4 -5/6 ETlo 5 -33 
All 0.7 - 2.4 5 - 9 0.1 - 24.7 56 - 69 0.2 -18.0 2.5 - 15.1 0.1 - 1.5 0.3 - 5.1 

2. 5/22 - 5/25 ETlo 5 -35 
NE -W-SW 0.6 - 2.3 5 - 12 2.1 - 31.6 59 - 69 0.3 - 16.8 1.6 - 12.0 0.2 - 1.5 1.4 - 6.0 

3. 9/8 - 9/13* T 10-40 
NE-NW-NE 0.5 - 2.0 5 - 10 1.7 - 37.5 55 - 69 1.8 - 13.8 2.8 - 9.8 0.2 - 1.3 1.3 - 6.4 

4. 9/30 - 10/2 ETf 10-25 
N-E 0.8 - 1.6 5 - 11 2.9 - 30.8 59 - 67 0.4 - 10.0 1.9 - 7.4 0.2 - 1.0 1.6 - 5.8 

5. 10/10 -10/14 T 10-35 
NE-S-N 0.6 - 2.2 5 - 10 1.6 - 18.9 60 - 68 0.3 - 11.0 3.3 - 6.0 0.1 - 0.8 1.1 - 4.5 

6. 10/22 - 10/24 ETlo 5-20 
N-NE 0.7 - 1.1 5 - 11 0.2 - 23.7 59 - 79 1.1 - 11.4 3.1 - 8.3 0.2 - 0.9 0.4 - 5.0 

7. 11/6 - 11/8  ETf 10-40 
S-W-N 0.7 - 1.7 4 - 11 #2.5 - 22.5 59 - 68 0.5 - 16.7 3.8 - 13.3 #0.5 - 1.2 #1.9 -5.9 

8. 11/12 - 11/14 Etlo 5-40 
SE-SW-N 0.9 - 1.5 4 - 18 0.2 - 14.3 59 - 68 0.9 - 11.6 3.2 - 7.2 0.2 - 0.9 0.4 - 4.1 

9. 12/20 - 12/22 ETf 19-41 
SE-W 0.7 - 1.9 5 - 10 8.2 - 32.9 59 - 68 0.9 - 15.4 2.7 - 7.0 0.3 - 0.9 3.0 - 6.0 

10. 12/25 - 12/27* ETlo 15-35 
SE-NW 0.6 - 1.8 6 - 9 6.0 - 24.2 59 - 68 0.7 - 17.1 4.1 - 14.8 0.2 - 1.5 2.6 - 5.0 
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2003 sediment mobility events.  Data below are recorded from January through October 2003. # - limited data due to equipment 
failure.  Etlo = extratropical low pressure area; T = tropical born system; ETf = extratropical frontal boundary; BH = southerly wind 
event.  Events denoted by an asterisk are highlighted in the Results section. 
 

2003 Events Type Winds 
(knots) 

Hs 
(m) 

Tp 
(sec) 

ub
(cm s-1) 

ABS 
(dB) 

Mean  
current 
(cm s-1) 

Subtidal 
current 
(cm s-1) 

u*c
(cm s-1) 

u*cw
(cm s-1) 

1. 2/4 - 2/6 Etf 10-40 
S-N #1.0 -1.5 3 - 11 #15.0 57 - 69 1.1 - 12.1 3.7 - 8.9 #1.0 #4.1 

2. 2/23 - 2/27 Etlo 15-50 
S-N-SE 0.7 - 2.1 4 - 11 1.9 - 42.9 61 - 72 1.3 - 17.8 4.0 - 12.2 0.2 - 1.4 1.5 - 7.0 

3. 3/16  3/18 Etlo 5-30 
ALL #0.8 - 2.0 3 - 10 #6.0 - 20.5 58 - 68 0.2 - 8.9 3.1 - 5.2 #0.3 - 0.8 #2.8 - 4.6 

4. 3/21 - 3/23 Etf 8-33 
SE-W #0.6 - 1.6 3 - 9 #6.5 - 26.3 56 - 68 0.6 - 13.6 3.1 - 7.9 #0.1 - 1.3 #2.5 - 5.3 

5. 4/6 - 4/9 Etf 10-35 
ALL 0.6 - 2.1 3 - 11 0.2 - 21.7 56 - 70 1.3 - 14.7 4.1 - 9.0 0.2 - 1.1 0.9 - 4.8 

6. 4/25 - 4/27 Etf 10 -38  
SE-W 0.6 - 1.9 4 -10 2.4 -18.1 50 - 68 0.4 - 10.4 2.4 - 7.1 0.2 - 1.0 1.4 - 4.4 

7. 5/23 - 5/25 ETlo 5-30 
SE-NW 0.8 - 1.9 5 - 13 2.4 - 27.5 55 - 68 0.7 - 11.4 2.3 - 7.7 0.1 - 1.1 1.4 - 5.5 

8. 6/7 - 6/10* BH 10-30 
SE-SW 0.7 - 1.6 6 - 9 4.0 - 23.4 54 - 67 0.7 - 14.1 1.4 - 10.9 0.3 - 1.2 1.9 - 5.1 

9. 7/23 - 7/25 BH 18-28 
S-SW 1.0 - 1.5 4 - 10 0.2 - 11.0 63 - 68 1.8 - 11.8 6.2 - 9.2 0.7 - 1.2 0.8 - 3.9 

10. 9/5 - 9/12 T 10-38 
SE-N-NW 0.7 - 2.2 5 - 16 2.1 - 43.2 59 - 70 0.1 - 18.0 1.8 - 11.0 0.1 - 1.5 1.3 - 7.1 

11. 9/15 - 9/20* T 10-60 
SE-N-SW 1.0 - 2.5 5 - 18 1.2 - 63.9 58 - 73 0.2 - 26.1 1.9 - 19.7 0.2 - 2.1 1.1 - 8.6 

12. 9/28 - 9/30 Etf 10-25 
SW-N 0.5 - 1.5 5 - 14 4.5 - 23.1 57 - 70 0.7 - 13.3 2.9 - 9.9 0.2 - 1.0 2.2 - 5.0 

13. 10/7 - 10/11 Etf 10-28 
E-N 0.7 - 1.7 4 - 12 2.7 - 26.1 57 - 68 0.5 - 15.9 2.5 - 11.6 0.3 - 1.3 1.7 - 5.3 



 

Appendix B:  Instructions for Using ISIS and DelphMap Side-scan processing software 
 

Navigation Correction  

1. Raw .XTF files are first modified using FIXHEADX.exe DOS utility.  This utility 

computes course made good for each sonar ping and sets the towfish heading to this new 

value.  See Chapter 4: DOS Utilities for Isis Data of DELPHS Utilities Manual for more 

information regarding this script.  Note: Once the script is run, original data heading data 

is overwritten with new towfish heading values.  

 
 

 

 

 

 

 

Replaying of Data File 

1. Open Isis Sonar v.6.  In the main window, choose FILE > PLAYBACK.  In the Disk or 

Playback box choose “Disk Playback.” 

a. All side-scan data for inner-shelf study site resides on F- disk> 5 Mile > cruise  

acquisition date > line_#.XTF. 

b. Choose New Volume(F:) > 5-mile > “Survey Date” > “line_#.XTF”.  This will initiate 

playback of line_#.XTF.   

2. Two “waterfall” windows will appear.  The active window will be highlighted “blue” and 

this is the frequency in which geometric and radiometric corrections will be applied.  

Right clicking the mouse button in the active “waterfall” will display the channels, which 

are being played back.   Channels 1 and 2 are the port and starboard channels for the 100 

kHz frequency and channels 3 and 4 are the port and starboard for the 500 kHz (384 

kHz).   
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a. Typical setup: Channel 1 & 2 selected in 100 kHz, Channel 3 & 4 in the 500 kHz, 100 

kHz window highlighted. 

            b. To replay the file again:  go to FILE > PLAYBACK and repeat #1.   

            c. Slow or speed up the playback by selecting the “walking guy” or “running guy”  

on the toolbar. 

3. Survey tracks for this project were obtained using minimal overlap between adjacent 

lines.  To ensure full coverage when constructing the final mosaic, the range scale over 

which data is processed needs then to be maximized. 

a. In VIEW > DEPTH, DELAY, DURATION use the slider bar to set duration to range 

between 100.98 - 106.36 m.  This change will be reflected in the “waterfall” window. 

Setting Bottom Tracking Parameters 

1. In VIEW > OVERLAY check on/off  “show bottom track” also known as “first signal 

return.”  This parameter is a detection of the seabed directly below the towfish and 

calculates the fish height. It is important for correcting errors due to slant range.  

a. Typical settings: 

Method: Amplitude 

Channel:  1 

Level: data dependent (range = 10 - 35%). 

Holdoff: data dependent (range = 8 - 14 m). 

b. Parameters should be modified such that the red “first signal return” line is coincident 

with the contact between water column and bottom return.  Replay file modifying 

above parameters until satisfactory.   

 

Slant-Range and Speed Correction 

1. Correcting for errors due to slant range involves geometrically repositioning sonar data to 

counteract the effects of range data compression.  Correcting for slant-range also removes the 

water column from the record.  Speed correction coordinates the speed of the survey vessel to 

the length of the sonar record.  
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a. Right click on “waterfall” window for each separate frequency.  In the “waterfall 

display” window check off correct for slant-range and speed.  Replay file to ensure that 

water column has been removed.  

Set Time Varying Gain (TVG) Parameters 

1. This application along with “Balance” are used to equalize returns across track in order to 

maintain an even image across the sonar record otherwise affected by attenuation.  In 

order to modify TVG, the voltage distribution across the swath must be viewed.  Go to 

WINDOW > SIGNAL > VOLTAGE ACROSS.   Right click on the VOLTAGE 

WINDOW to make sure the 100 kHz signals are visible (1, 2).  Manipulate windows so 

they cascade vertically.  Optimal result is one where voltage is relatively equal across 

entire swath.   

a. Typical settings: 

Channel: All 

Standard: Off 

Start at: Transmit 

DC Offset: +0.00 v 

Balance: On (√) 

Darkness: 4% Max                       

Decay Rate: 24 

Creating the Mosaic 
1. In TOOLS > COVERAGE MAP AND MOSAIC OPTIONS check “Full DelphMap 

mosaic.”  This will initiate opening of the “Delph Mosaic and DTM” window.   Click 

“set projection and bounding box.” 

a. Typical map and projections settings: 

Resolution: 0.25 m 

Depth: < 2000 m 

Units: dd.dddd 

Output Projection: Universal Transverse Mercator, Zone 18 

Datum = WGS Datum (1984) 
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b. Under “more options” check “apply nav from mosaic and enter setup.  Choose 

“compute layback from cable out,” check off “cable out.”  Enter the following 

typical settings and “apply” the changes. 

Cable Out: 15 m 

Offset: 11 m 

Hypotenuse Formula: On 

c. Other setup options: 

For sensor direction use: Course made good 

Fill gaps between pings: On 

Merge overlapping lines by: Cover up 

 

 

 

 

 

 

 

 

 

 

 

 

2. Return to “Delph Mosaic and DTM” window and click on “Build Sidescan Mosaic.”  

Click on “Start Mosaic” to specify mosaic file name.  Save file as a geoenoded file with 

*.DDS_VIF tag.  Once “save” has been clicked, return to “Isis Main Window” and 

playback the line to be mosaicked.  

 

3. Open DelphMap v2.9 and import processed lines accordingly.   Under GIS Tools > Color 

Palettes make the following modifications.   Gray shade pixel values are reversed to 

highlight high-energy backscatter returns as black and lower energy returns with 

correspondingly lighter colors fading to white.  
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Data Type: Sidescan 

Palette: Gray 

Pallette Density: Linear (normal)  

Minimum:  10 

Maximum: 233 

Reverse: On 

 

4. After all lines have been inserted into DelphMap merge individual lines are merged into 

one large mosaic file.  This is appropriate for a regional view of surveyed area and to 

observe large-scale features on the seabed.  For applications used in this research, lines 

were exported individually to be georeferenced relative to one another and limit 

navigation errors inherent in sidescan acquisition.  

a. To create mosaic go to TOOLS > MERGE IMAGE LAYERS and use the 

following settings: 

Use Shinethrough: on 

Keep Maximum Values (Shinethrough): On  

Insert output layer into project: On   

 

 

 

 

 

 

 

 

b. To georeference individual lines relative to each other: 

i. Using DelphMap export individual lines from a given survey as geotiff 

image files with  the *.TIFF  tag.  In doing so, a secondary file (*.tfw tag) 

is created containing the necessary geographic information needed to 

place this image in it’s proper space in a given coordinate system.   This 

 80



 

header file, also known as a world file consists of the upper left-hand 

corner coordinates of the image as well as current pixel resolution. 

ii. Use a GIS software package to view individual lines.  ARCVIEW 3.2 was 

used in this research.  

iii. Choose a well-defined benchmark that preferably runs perpendicular to 

multiple lines.  Manipulate coordinates given in the world file to move the 

mosaic in space until the chosen fixed point is aligned across the lines.   

Repeat with other fixed features as needed.  For purposes presented here, 

this method established a higher degree of confidence in analyses of 

temporal changes of sediment boundary locations across repeat mosaics of 

the same area.  
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Appendix C: Instructions for Calculating Sand Body Displacement 

 

1. Open ArcView 3.X.  Go to File>Extensions and turn on XTools extension script.  

a. XTools defaults used in this study are as follows: 

Map Units: meters 

Output Map Units: Meters 

View Distance Units: Meters 

Area Output Units: Both acres and hectares 

Convert overlay output shapes to single point: No 

Calculate Area, Perimeter, Acres, Length: Yes 

Do NOT show View Properties: Off 

Do NOT show the XTools Default: Off 

Projection: none 

 

2. Digitize Sand Body 

a. Select “Draw Polygon” feature from the toolbar and digitize the perimeter of the 

chosen sand body.  This will create a new “graphic” shape. 

b. To convert graphic to shape file go to XTools>Convert Graphics to Shapes.   

c. Go to Edit> Delete Graphics and then turn on the newly formed “sandbody1.shp” 

file to view. 

d. Repeat for same sand body from subsequent survey date. 

 

3. Calculate Intersection 

a. Go to XTools>Intersect Themes. Select the two newly created “sandbody.shp” 

files to be intersected and choose a new a new output theme name. 

b. Turn on the newly formed “intersection.shp” file to view. 

 

4. Calculate Individual Area 

a. Go to XTools>Calculate Area, Perimeter, Length, Acres, Hectares. 

b. Select the newly formed “intersection.shp” file to calculate the area in square 

meters.  
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c. Repeat for the “sandbody.shp” files from each chosen survey.   

d. To obtain the area in square meters, first make the theme you wish to observe 

active.  Select the “identify” tool on the toolbar.  In the “View” window click on 

the region coincident with the active theme and the area statistics will be 

displayed. 

 

5. Calculate Displacement Area 

a. Sum the “individual areas” of the two sand bodies.  Divide this number by two to 

obtain the average size of the sand body over the period.  

b. Subtract the “area of intersection” from the above to obtain the area of 

displacement in square meters.  

c. Overlay the sand bodies to determine direction of displacement.   
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Appendix D: Change detection analysis results of selected lower sand flat sand bodies. 

CSB #1 
Sample 

Date 

Coarse 
Sand 
Area 
(m2) 

Displacement & 
Direction  from 
Spring ‘02 (m2)

Displacement & 
Direction  from 

Fall ‘02 (m2) 

Displacement & 
Direction  from 
Spring ‘03 (m2) 

Displacement & 
Direction  from 

Fall ‘03 (m2) 

Spring ‘02 4775 n/a 315  ND X 413  ND 
 

Fall ‘02 4477 315  ND n/a 438 W-NW X 

Spring ‘03 3870 X 438 W-NW n/a 490 E 

Fall ‘03 4449 413  ND X 490 E n/a 

CSB #2 
Sample 

Date 

Coarse 
Sand 
Area 
(m2) 

Displacement & 
Direction  from 
Spring ‘02 (m2)

Displacement & 
Direction  from 

Fall ‘02 (m2) 

Displacement & 
Direction  from 
Spring ‘03 (m2) 

Displacement & 
Direction  from 

Fall ‘03 (m2) 

Spring ‘02 1731 n/a 233 ND X 180 N 
 

Fall ‘02 1420 233  ND n/a 257.27  ND X 

Spring ‘03 1666 X 257 ND n/a 152 N-NE 

Fall ‘03 1748 180  N X 152 N-NE n/a 

Results from change detection analysis of Coarse Sand Body #1. 
ND – no net directional component X - not recorded     n/a - not applicable 
 

 
 
 
 
 
 

 

 
Results from change detection analysis of Coarse Sand Body #2. 
ND – no net directional component X - not recorded     n/a - not applicable 
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FSB #1 
Sample 

Date 

Fine 
Sand 
Area 
(m2) 

Displacement & 
Direction  from 
Spring ‘02 (m2)

Displacement & 
Direction  from 

Fall ‘02 (m2) 

Displacement & 
Direction  from 
Spring ‘03 (m2) 

Displacement &  
Direction  from 

Fall ‘03 (m2) 

Spring ‘02 321 n/a 
63  

ALL ≠ N/NE X 120 N-NW 
 

Fall ‘02 421 63 ND n/a 146 N-NW X 

Spring ‘03 386 X 146 N-NW 
 

n/a 46 SE 

Fall ‘03 329 120 N-NW X 46 SE n/a 

R
A
N
 

 

 \ 
Results from change detection analysis of Fine Sand Body #1. 
ND – no net directional component X - not recorded     n/a - not applicable 
 

 

FSB #2 
Sample 

Date 

Fine 
Sand 
Area 
(m2) 

Displacement & 
Direction  from 
Spring ‘02 (m2)

Displacement & 
Direction  from 

Fall ‘02 (m2) 

Displacement & 
Direction  from 
Spring ‘03 (m2) 

Displacement & 
Direction  from 

Fall ‘03 (m2) 

Spring ‘02 3386 n/a 312* ND X 443 ND 
 

Fall ‘02 3478* 312* ND n/a 545* N X 

Spring ‘03 4087 X 545* N 
 

n/a 588 ND 

Fall ‘03 3805 443 ND  X 588 ND n/a 

 
 
 
 

esults from change detection analysis of Fine Sand Body #2.  
sterisk (*) denotes loss of NE corner of data due to nadir region.  
D – no net directional component X - not recorded     n/a - not applicable  
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FSB #3 
Sample 

Date 

Fine 
Sand 
Area 
(m2) 

Displacement & 
Direction  from 
Spring ‘02 (m2)

Displacement & 
Direction  from 

Fall ‘02 (m2) 

Displacement & 
Direction  from 
Spring ‘03 (m2) 

Displacement & 
Direction  from 

Fall ‘03 (m2) 

Spring ‘02 2603 n/a 478 S-SW X 538 W 
 

Fall ‘02 3532 478 S-SW n/a 384 ND X 

Spring ‘03 3566 X 384 ND 
 

n/a 540 ND 

Fall ‘03 2490 538 W X 540 ND n/a 

 

 
Results from change detection analysis of Fine Sand Body #3. 
ND – no net directional component X - not recorded     n/a - not applicable  
 
 

FSB #4 
Sample 

Date 

Fine 
Sand 
Area 
(m2) 

Displacement 
& Direction  
from Spring 

‘02 (m2) 

Displacement & 
Direction  from 

Fall ‘02 (m2) 

Displacement & 
Direction  from 
Spring ‘03 (m2) 

Displacement &  
Direction  from 

Fall ‘03 (m2) 

Spring ‘02 
*over nadir 12816* n/a 1378 ND X 869 ND 

Fall ‘02 
*over nadir 14717* 1378ND n/a 750 ND X 
Spring ‘03 
*over nadir 13842* X 750 ND 

 
n/a 832 ND 

Fall ‘03 
*over nadir 12779* 869 ND X 832 ND n/a 
 
 
 

Results from change detection analysis of Fine Sand Body #4. 
ND – no net directional component X - not recorded     n/a - not applicable 
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